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Languages
To go directly to your preferred language, click on the links below.

English

한국어

日本語
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I N T R O D U C T I O N

First Rush is a multi-camera on-set recorder for macOS. It records SDI or supported
capture-card inputs to editable video files, and lets you manage Scene / Cut / Take
metadata and file-naming rules right inside the recording workflow. As of First Rush 2.3.0,
the Live Tools panel includes live color grading, scopes, exposure and focus aids, real-time
compositing, clip playback, processed SDI program out for DeckLink / AJA workflows, and
an SDI routing patchbay.

The screenshots in this manual were captured with a mock source rather than a live set, so
some on-screen text appears in English regardless of your system language; feature
locations and workflow are identical. When a real camera is connected, preview, timecode,
audio and SDI metadata are shown according to your hardware and signal.
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C H A P T E R  1

Requirements

First Rush requires an Apple Silicon Mac and the vendor driver for your capture hardware.

Supported capture device families:

Blackmagic Design DeckLink / UltraStudio.

AJA devices.

Recommended before going on set:

Install Blackmagic Desktop Video or AJA Desktop Software first.

Confirm the capture device is recognised in the vendor utility.

Confirm camera video, embedded audio and timecode reach the capture device.

Provide enough storage for ProRes recording.

Always do a short test recording before the first take.
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C H A P T E R  2

Installation, Licensing and Updates

1. Download the latest First Rush DMG.

2. Open the DMG and drag First Rush to the Applications folder.

3. Launch First Rush.

4. Allow camera / audio access when macOS asks. This permission is for the capture-card input,
not the Mac's built-in camera.

First Rush is an Apple-notarized build, so it opens without a Gatekeeper block on first launch. If you
see an "unidentified developer" warning, the DMG was probably corrupted in transit — download
and install it again.

Subscription and free trial

First Rush is a subscription. On first launch a license sheet appears.

Start free trial: begin a 7-day free trial through the First Rush store. The trial unlocks the full
app; a countdown is shown in the menu bar and license sheet.

Enter license key: paste the key from your purchase email and activate. A key is bound to one
Mac; deactivate / reactivate from the license sheet to move it.

The direct-purchase subscription is a single all-features plan: ₩20,000 per month or ₩200,000 per
year. Displayed prices exclude VAT; applicable tax is added at checkout. Mac App Store
subscriptions may appear ₩1,000 higher per month / year because of Apple's pricing structure.

When the trial or subscription lapses, recording locks and the sheet reappears. Signal diagnostics
and the Activity Log remain available in that state. To review license info or move it to another Mac,
use First Rush > License… .

Sparkle automatic updates

The direct-download DMG build updates itself through the Sparkle framework.

Shortly after launch it polls an EdDSA-signed appcast.xml .

When a new build exists, an update sheet appears. Install Update downloads, verifies, installs
and relaunches in one flow.

Check manually from First Rush > Check for Updates… .
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On a closed set network you can ignore updates safely — the existing build keeps working.

The Mac App Store build updates through the App Store instead and does not use Sparkle.
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C H A P T E R  3

The Main Window

The main window has these regions:

Left source sidebar: camera / capture input list.

Centre viewer grid: preview, recording state, timecode, audio meters, source overlays.

Right inspector: metadata, SDI diagnostics, preview effects, LUT, destination assignment,
auto-record settings.

Bottom slate strip: Scene / Cut / Take entry and slate modes.

Bottom gang-control bar: record / stop control for the selected or active sources.

Live Tools panel: a dockable bottom panel for Color, Monitor, Composite, Playback and SDI
Out. Toggle it with Option-Command-G  or from the View menu.

The top-right toolbar toggles layout, VU meters, timecode display, info overlay, slate strip, Activity
Log and the inspector.

Layout menu

Change the viewer-grid arrangement from the Layout  menu or the toolbar layout button.
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Layout menu

Auto Layout : fits the grid to the number of active sources.

Single  / 2 x 1  / 2 x 2 (4)  / 3 x 3 (9)  / 4 x 4 (16) : fixed grids.

Primary + Right Strip : one main view plus a thumbnail strip.

Enable Portrait Mode (CW 90°)  / Cycle Portrait Mode : vertical / 9:16 monitoring.

Toggle Fullscreen : full-screen the current viewer.

Auto Layout suits sets where the source count changes often; Primary + Strip is best when one
camera is the monitoring priority.
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C H A P T E R  4

Sources

Open the Cameras  tab in the left sidebar to see capture sources.

Cameras tab

Each source row shows the hardware backend (Blackmagic or AJA), the source name, signal / run /
record state, and an enable switch. Turn a source on before recording. If "No signal" appears, check
the camera output format, cabling, capture-card input routing and driver state.

Source settings

Select a source and press the gear button at the bottom of the sidebar, or the metadata-tag button
on a viewer tile, to open Source Settings.



12

Source settings

Source name: the name shown in the UI.

Clip metadata: Scene, Take / Shot, Reel / Tape, Reel #, Camera make / model, Camera label,
Director, DP, Production, Notes. This is written into the recorded file as QuickTime userdata
and auto-populates Tape / Scene / Shot columns in Final Cut Pro and DaVinci Resolve.

Video settings: input format (Auto-detect recommended), SDI / HDMI choice for hybrid AJA
inputs, and full-gate crop.

SDI port direction: DeckLink / AJA connectors that can output can be switched from input to
output. The control is locked while recording or while Clip Playout is active.

Audio settings: channel count, bit depth, phase invert, audio delay (-30 to +30 frames),
channel mapping and audio source.

Pre-Record buffer: Keeps the last 0-30 seconds in memory and writes that lead-in when
recording starts.

Timecode / Auto-record trigger: Choose the timecode source (SDI Embedded, Audio LTC,
Mac Clock), REC Flag (SDI/HDMI) , HDMI TC Run (Beta) , and camera-specific Record
Flag presets.

Full Gate is for open-gate / anamorphic workflows where you need to avoid HUD or black-border
areas inside the signal. Use Auto Detect , then adjust left / right / top / bottom insets from 0-
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25%. The preview shows guides; actual recording behavior follows the destination / preview-effects
recording settings.

Multi-apply (Cmd-Click)

To set several cameras to the same values at once, Cmd-Click  multiple sources in the sidebar.
Selected sources are highlighted, and any Inspector / Source Settings change you make then
applies to all of them. This is destructive — existing values on the selected sources are overwritten,
so deselect any source that needs special settings.

Cross-source audio routing

Audio Source  defaults to each source's own SDI embedded audio, but you can route another
source's audio into this source's recording. Typical on-set case: A-cam only has a distant mic, B-
cam carries the boom — set A's Audio Source  to B and A's file records the boom. Routing takes
effect from the next clip; a clip already recording finishes with its own audio.
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C H A P T E R  5

Destinations

Set recording destinations in the Records  tab of the left sidebar. Each destination defines a folder,
a codec preset, a file-naming rule, video settings, audio-track layout and post-record options. Select
a destination and press the gear button to open Destination Settings.

Destination settings

Main destination options:

Record effects: rotation, deinterlace, timecode burn-in, source-name burn-in and overwrite
behavior.

Loop Recording: On-set option that keeps a minimum amount of free space and rotates old
clips.

Post Process Script: Runs a selected script after a recording completes and can move the
result to a Watch Folder.

Auto Split: Splits long recordings by 15 / 30 minutes, 1 / 2 / 4 hours, or 2GB / 4GB.

Video: Writes color-space metadata such as Rec.709, Rec.2020, Rec.2020 PQ / HLG and P3
D65; H.264 profile and H.264 / HEVC bitrate apply to inter-frame codecs.
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Audio Tracks: Configure track name, channel count (1 / 2 / 4 / 6 / 8), language code and
input-channel mapping per destination.

File naming

Build the file name from the token palette, for example:

S  + Scene  + _C  + Shot  + _T  + Take(auto)  + -  + CamLabel  -> S15_C02_T01-

A.mov

The Preview line shows the next file name.

The preset menu includes Date_Time_Source, Camera Letter, Slate, Scene_Cut_Take-Cam, ARRI
Camera Reel, ARRI Reel + Slate and Test Clip formats. The token palette includes Year / Month /
Day / Timecode / SourceName / DestinationName / Reel / Round / ClipName / Scene / Shot / Take /
CamLabel / Episode, and a /  literal can be used to create folder levels.

Codec presets

ProRes 422 Proxy: light proxy for on-set editorial.

ProRes 422 / HQ and above: higher quality for editorial or post delivery.

DNxHR / H.264 / HEVC: where enabled by the build and destination.

For on-set editorial, ProRes 422 Proxy is the safest default.
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C H A P T E R  6

Slate Strip

The bottom slate strip applies Scene / Cut / Take values to multiple sources at once.

Modes: Film, Drama (episode prefix), Reel (camera reel / clip name), Test (separate counter), Custom
(free-form). Editing Scene / Cut / Take immediately pushes the current slate into source metadata
and the next clip name. Turn on Auto +Take  to advance Take after a recording cycle finishes.

Enable Auto Folder  to create and sort recordings into folders under the destination based on
round / date / Scene / Reel / Episode templates. Use the folder gear button to edit the template for
the current slate mode. The Round  value pins the shoot date so overnight shoots can stay in one
round folder even after midnight.
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C H A P T E R  7

Recording

Manual recording

Use the bottom control bar — REC  to start, STOP  to stop — or the Recording menu's Record

All  / Stop All  for the selected or all active sources.

Shortcuts: Command-R  Record All, Command-K  Stop All, Command-P  Pause All, Shift-

Command-P  Resume All, Command-M  insert chapter marker.

Chapter markers

Press Command-M  while recording to drop a chapter marker at the current timecode.

The marker is applied to every active clip at once (gang marker).

Markers are written directly into the recorded .mov  as a QuickTime chapter track, so they
open as chapters / markers in Final Cut Pro and DaVinci Resolve with no separate export step.

Markers are auto-labelled ( Marker 01 , Marker 02 …); rename them in your editor if
needed.

Marker events are also written to the Activity Log.

Still frames

Recording > Save Still  ( Shift-Command-S ) saves a still from the selected source; Save

Stills (All Cameras)  captures every active source at once. Stills are baked from the current
processed image.

In Preferences > General > Still Capture , choose the still folder, format (PNG / JPEG /
TIFF), grade bake (CDL+LUT) and look sidecar (ACES AMF + ASC CDL). If the folder is empty, First
Rush uses a Stills  folder inside each destination.

Automatic recording

Turn on Auto record per source in the Inspector. A source needs at least one destination assigned
for auto record to work.
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Auto-record trigger settings

Two trigger modes:

REC Flag (SDI/HDMI) : the default, stable path — DeckLink record-trigger flag or AJA
RP188 record flag.

HDMI TC Run (Beta) : a DeckLink-HDMI helper — recording starts when timecode runs
and stops when it stops.

For SDI cameras, keep REC Flag . For Sony mirrorless over HDMI, set HDMI Time Code Output:
On, REC Control: On, TC Run: Rec Run.
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C H A P T E R  8

Metadata and Auto-Fill

First Rush writes clip metadata into the recorded file and lets you edit the same fields in the
Inspector: Scene, Cut / Shot, Take, Reel / Tape, Reel number, Clip name, Camera make / model,
Camera label, Notes.

The SDI camera-info area reads camera data from VANC / ANC packets and HUD OCR. On
supported signals it can auto-fill Reel, Clip name, ISO, White Balance, Shutter and Lens.

Diagnostic chips: TC  timecode seen, REC  record flag seen, ANC  ancillary metadata seen,
Audio  embedded-audio state, OCR  HUD OCR state. When auto-fill is not working, read these

chips first.

HUD OCR

For cameras that don't carry metadata in ANC (many mirrorless and some cinema HDMI outputs),
First Rush reads the on-screen HUD with OCR — Reel name, Clip name, ISO / EI, Shutter, White
Balance / Tint and compatible Lens data. It samples the HUD region every 1–2 seconds, matches a
per-vendor layout (ARRI / RED / Sony / Blackmagic), recognises text with the Vision framework, and
fills only successful values when Auto-fill  is on.

For best results the HUD must be clearly visible in frame; a heavy monitoring LUT or a down-
converter can lower OCR accuracy. Help > Export SDI Diagnostic…  includes OCR attempt /
success counts — attach it if recognition is poor.
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C H A P T E R  9

Preview Effects and LUT

The Inspector's Preview / recording effects section sets preview corrections and guides: Auto crop,
Keep HUD metadata, Grid, Letterbox, Rotation, Flip H / V, Center Cross and a Preview LUT. These
are preview-only by default; turn on Apply to recording  only when you want them baked into
the file.

Keep HUD metadata  pins top / bottom HUD metadata areas to the edge while scaling or
cropping. Auto crop  re-detects black bars or red safe-frame boundaries, and Grid can show
thirds / fifths / crosshair guides.

Aspect ratio and safe frame

Letterbox / Pillarbox guides: overlay 2.35:1, 2.39:1, 2:1 or 4:3 guides on a 16:9 signal for
framing reference (preview only).

Portrait / 9:16: turn on Portrait Mode for Reels / Shorts; drag the 9:16 crop to follow the
subject, and turn on Apply to recording  to record the cropped frame. Cycle Portrait

Mode  rotates 16:9 -> 9:16 -> 9:16 (left) -> 9:16 (right).

3D LUT preview (.cube)

Open Pick LUT…  in the Preview LUT area, choose a .cube  file (Rec.709 conversion, look or
camera LUT) and it applies to preview immediately; adjust strength with the slider. Turn on Apply

to recording  to bake the LUT, or make a dedicated LUT-baked proxy destination while keeping a
clean LOG master. 17 / 33 / 65 cubes are supported.
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C H A P T E R  1 0

Live Tools — Color and Scopes

Open the Live Tools panel ( Option-Command-G ) and select the Color tab. Pick the source to
grade from the panel header.

Live Tools — Color and scopes

Color wheels

Lift, Gamma, Gain and Offset wheels give a primary grade:

Drag inside a disc to set color balance (relative trackball).

The slider under each wheel is the master (level) control.

Double-click a disc to reset its balance.

The grade is ASC CDL math, so it round-trips cleanly. Use Export .cdl  / Load .cdl  to
exchange grades, Save Look  / Looks  to store and recall looks, and Copy  / Paste  to move
a grade between sources.
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CDL, LUT and view modes

The CDL (ASC)  toggle enables the CDL grade.

Pick LUT…  loads a .cube  LUT on top of the grade.

The Graded  / LUT only  / Original  buttons switch what the viewer shows, so you can
compare the grade, the LUT alone, and the untouched source.

The Sat  slider sets saturation.

Bake into recording (CDL -> LUT)  records the graded image instead of the clean
source.

Scopes

The right side of the panel shows live scopes — Waveform, RGB Parade, RGB Overlay,
Vectorscope, Histogram and Chromaticity. Click a scope to open it in its own resizable window. The
scopes follow the selected monitoring color space (Rec.709 / Rec.2020 / P3 / Rec.601) for correct
readings, including HDR monitoring.
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C H A P T E R  1 1

Live Tools — Exposure and Focus Aids

Select the Monitor tab in Live Tools. These aids are preview-only — they do not affect the
recording, SDI output or scopes.

Live Tools — exposure and focus aids

False Color: maps exposure zones to colors so you can set exposure at a glance.

Zebra: stripes highlight-clipping areas.

Peaking: highlights in-focus edges to confirm critical focus.
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C H A P T E R  1 2

Live Tools — Compositing

Select the Composite tab to combine the source with a plate in real time — useful for green-screen
monitoring and previs on set.

Live Tools — compositing

Plate: choose the background source / image to composite against.

Chroma key: key out green / blue with similarity, smoothness, edge choke and spill
suppression. Use Show Matte  to preview the matte while adjusting.

Mix, Wipe, Diff: blend modes for comparison and overlay; the wipe has an adjustable angle
and feather.

Draw Mask: an ellipse / rectangle matte (position, size, feather, invert) to limit the composite to
part of the frame.

Composite Monitor: shows the composited result as a virtual tile in the viewer grid (or a
separate window), leaving the main tile clean.
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Bake composite into recording: records the composited image. Off by default, so the master
stays clean.
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C H A P T E R  1 3

Live Tools — Clip Playback

Select the Playback tab to review recorded clips or open a file without leaving First Rush.

Live Tools — clip playback

Recorded clips appear in the clip list; Play File…  opens any movie.

Transport controls give play / pause, frame step, scrub and speed. In the player window, use
Space (play / pause), ← / → (step one frame), J / K / L (reverse / stop / forward) and I / O (IN /
OUT).

With SDI output hardware, playback can go out to a monitor; without it, First Rush falls back to
an in-app player so you can still review on the Mac.

For hardware SDI playout, designate an output port as Clip Playout in the SDI Out tab or
Preferences > SDI Routing. In 2.3.0 the output designation and gating were tightened so clip
playout and Program Out do not fight for the same output card.

The clip list is per session and resets when the app restarts; use the refresh control to rescan, and
the row context menu to remove an entry (the file is kept).
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C H A P T E R  1 4

Live Tools — SDI Program Out

Select the SDI Out tab to mirror a source to an SDI output connector.

Live Tools — SDI program out

Program out (mirror this source to SDI output): sends the source to an output-capable card
connector.

Processed — grade, composite, rotation applied to output: when off, the output is a clean
feed (raw input mirror); when on, the SDI output carries the same grade, composite and
rotation you see in preview. In 2.3.0, processed output applies to supported AJA SDI output as
well as DeckLink output.

AJA output is designed around HD / 2K progressive workflows. Version 2.3.0 also stabilizes the
vertical roll that could appear on free-running camera feeds.

Program out needs a card connector configured as an output — see the SDI Out tab or
Preferences > SDI Routing.
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C H A P T E R  1 5

External Monitor (AVOut)

The External Monitor  menu opens extra full-screen monitoring windows for directors' and
clients' displays, separate from the main window.

Add AVOut Window : opens a new output window; place it on the target display and choose
the source to show.

Close All AVOut Windows : closes every output window.

AVOut windows are for monitoring only — recording is always handled by the main destination.
When running four or more recordings at once, keep AVOut windows to a single source for stability.



29

C H A P T E R  1 6

Companion Viewer (iPhone / iPad)

Companion Viewer streams a monitoring preview to an iPhone or iPad over the same local network,
or directly (P2P) when there is no router on set. The viewer is monitoring only and never records.

Open Companion Viewer > Companion Viewer…  ( Command-Option-V ).

Companion Viewer panel

Install the viewer app

First Rush Viewer is a free iPhone / iPad app — search "First Rush Viewer" on the App Store. It
needs iOS / iPadOS 17 or later and local-network permission (asked on first launch); camera
permission is only used for QR pairing.

Connect

1. On the Mac, open the Companion Viewer panel and start the server — Create Pairing

Code  starts it and issues a code in one step.

2. A 6-digit code and a QR code are shown.
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3. Open First Rush Viewer on the device; the Mac is discovered automatically.

4. Select the Mac, then enter the 6-digit code or scan the QR code.

5. Choose a layout ( 1 Cam – 4 Cam ) and which cameras to show.

The Mac appears to the Viewer app on the same local network via Bonjour. A code is valid for 5
minutes and can pair several devices; a paired device reconnects automatically. Restarting the
server or the app resets pairing — issue a new code.

Without a router (P2P)

With no shared Wi-Fi, the Mac and device connect directly (Mac First Rush 2.0.1+ and Viewer 2.0+).
No setup is needed; quality is automatically limited on P2P to protect bandwidth — use shared Wi-
Fi for higher quality.

Security and limits

Recording is always on the Mac; the viewer shows VIEW ONLY .

No connection without the 6-digit code.

If screen recording or mirroring is detected, the image is hidden and Screen Capture

Protected  is shown.

Video only — audio and timecode are not sent.

The Mac's live color / composite is not applied to the companion stream; the raw camera
image is sent.
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C H A P T E R  1 7

On-set Control and Remote Aids

The Inspector also contains on-set control aids:

Stream Deck: Connect an Elgato Stream Deck over USB and map per-button actions. Enable
HID connection and assign Record / Stop / Pause / Take / Marker-style actions.

Network Sync: Multi-Mac option using Leader / Follower roles. Use one Mac as Leader and
the others as Followers to keep remote session state aligned.

Web Remote: Allows basic browser control from the same LAN at http://<this-Mac-

IP>:port . Use it only on trusted production networks; do not expose it to the public internet.
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C H A P T E R  1 8

Activity Log and Diagnostics

Open View > Activity Log .

Activity and logs

The Activity & Logs window shows CPU, memory, free disk and active recordings, plus source and
recording events, with search, clear and export. To report a signal problem use the Help menu:
Copy SDI Diagnostic , Export SDI Diagnostic… , Email SDI Diagnostic… . The

diagnostic includes app version, signal format, timecode, record flag, audio channels, a recent ANC
summary, OCR attempt / success counts and metadata-source state.
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C H A P T E R  1 9

Preferences

Open Preferences with Command-, . It has four tabs.

Preferences — General

General: language (follows the macOS system language), default viewer layout, default panels,
and Display / Panels toggles for the system dashboard, source sidebar, inspector, slate bar
and Live Tools panel. The same tab also contains Still Capture and reset controls.

Still Capture: configure still folder, PNG / JPEG / TIFF format, grade bake and AMF/CDL look
sidecars.

Reset Settings: reset window / preview, Slate, or app defaults. License, destinations and per-
source recording presets are preserved.

Shortcuts: map a Wacom tablet's ExpressKeys to First Rush actions — F13 Record all, F14
Stop all, F15 Pause, F16 Take +, F17 Take −, F18 Chapter marker, F19 Select all sources —
with Command-R  / Command-K  / Command-M  as normal-keyboard fallbacks.
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Preferences — Shortcuts

SDI Routing: assign each connector as input or output per card, and map outputs to Program
Out or clip playout. Output connectors leave the source list and are switched back from the
sidebar's SDI Output Ports row. In 2.3.0, the patchbay can connect PGM OUT by dragging an
input dot onto an output dot; the existing click-to-arm / click-output flow still works, and
clicking a patched output removes the connection.
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Preferences — SDI Routing

License: subscription / trial status and license management. Payment-overdue grace, offline
grace and expired states are shown here.
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C H A P T E R  2 0

Troubleshooting

No signal — check camera output format, capture-card input routing, the SDI / HDMI cable, device
recognition in the vendor utility, and that the source is enabled.

No audio — check that the camera output carries embedded audio, source channel count and bit
depth, destination audio tracks, channel mapping, and mute / master volume.

Auto record won't start — check that the source's Auto record is on, that it has a destination, the
trigger mode, the REC flag (SDI) or HDMI TC settings (Sony), and the Activity Log for REC  /
STBY  / cooldown messages.

Metadata won't auto-fill — check the TC  / ANC  / OCR  chips, that the camera actually sends
metadata, that converters / wireless / switchers aren't stripping ANC, that the HUD is readable, and
that Auto-fill is on.

File name unexpected — check slate mode, Scene / Cut / Take values, the destination token,
camera label and Auto +Take .

Stills are saved to the wrong folder — check Preferences > General > Still Capture . If
the folder is empty, First Rush uses a Stills  folder under the destination.

The Viewer app cannot find the Mac — make sure the Mac and iPhone / iPad are on the same
local network, the Companion Viewer server is running on the Mac, and Local Network permission is
allowed on iOS.

The Help chatbot does not open — Help > AI Assistant  opens
https://editorhan.me/first-rush/help . If the production network blocks internet access,

keep the PDF manual available locally.
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C H A P T E R  2 1

On-Set Checklist

Before the first take: capture device recognised; all sources visible; signal, timecode and audio
confirmed; destination folder set; codec preset checked; file-name preview checked; Scene / Cut /
Take set; trigger mode checked if using auto record; a short test recording opened in your editor.

While shooting: watch the red recording border and REC timer; watch free disk space; confirm Auto
+Take; keep an eye on the TC / REC / ANC / Audio / OCR chips when metadata matters.

After a settings change: re-check signal format, audio channel mapping and trigger mode, and do
another short test recording.
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C H A P T E R  2 2

Keyboard Shortcuts

Recording: Command-R  Record All, Command-K  Stop All, Command-P  Pause All, Shift-

Command-P  Resume All, Command-M  Chapter marker, Shift-Command-S  Save Still.

Slate and metadata: Scene / Cut / Take edits apply automatically. Command-]  / Command-[  Take
+/−, Shift-Command-]  / Shift-Command-[  Scene +/−, Option-Command-]  / Option-

Command-[  Cut +/−.

Selection: Cmd-Click  multi-select sources, Shift-Click  range select, Command-A  select all
sources.

View and layout: Command-1  / 2  / 3  / 4  Single / 2×2 / 3×3 / 4×4, Option-Command-0

Auto Layout, Command-F  Toggle Fullscreen, Option-Command-S  Source Sidebar, Option-

Command-I  Inspector, Option-Command-L  Slate bar, Option-Command-G  Live Tools panel,
Option-Command-Y  Activity Log.

Output: Command-Option-V  Companion Viewer panel, Shift-Option-Command-O  Add AVOut
Window, Shift-Option-Command-W  Close All AVOut Windows.

The shortcut shown next to each menu item is authoritative; some shortcuts vary by build or macOS
environment.
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C H A P T E R  2 3

Menu Bar Reference

First Rush

About First Rush  (version / build / builder), Check for Updates…  (Sparkle),
Preferences…  ( Command-, ), License… , Hide / Quit .

File

New Window , Close .

Edit

Standard macOS edit menu (Undo / Redo / Cut / Copy / Paste / Select All), used in slate and text
fields.

View

Show Tab Bar  / Show All Tabs , Toggle Source Sidebar , Toggle Inspector

( Option-Command-I ), Toggle Slate Bar  ( Option-Command-L ), Live Tools Panel
( Option-Command-G ), Activity Log  ( Option-Command-Y ), Enter Full Screen .

Recording

Select All Sources , Record All  ( Command-R ), Stop All  ( Command-K ), Pause All
( Command-P ), Resume All  ( Shift-Command-P ), Insert Chapter Marker  ( Command-M ),
Save Still  ( Shift-Command-S ), Save Stills (All Cameras) .
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Recording menu

Layout

Auto Layout , Single , 2 x 1 , 2 x 2 (4) , 3 x 3 (9) , 4 x 4 (16) , Primary +

Right Strip , Enable Portrait Mode (CW 90°) , Cycle Portrait Mode , Toggle

Fullscreen .

External Monitor

Add AVOut Window , Close All AVOut Windows .

Companion Viewer

Companion Viewer…  ( Command-Option-V ), Start Companion Viewer , Create Pairing

Code .
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Window

Standard macOS window menu.

Help

AI Assistant  (web chatbot), Email Developer , Copy SDI Diagnostic , Export SDI

Diagnostic… , Email SDI Diagnostic… , Bug Report… , Open Activity Log .

Menu items and shortcuts can vary slightly by build / environment; the on-screen menu is
authoritative.
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소개

First Rush는 macOS용 멀티카메라 현장 레코더입니다. SDI 또는 지원되는 캡처 카드 입력을 편집 가능
한 영상 파일로 녹화하며, 녹화 워크플로 안에서 곧바로 Scene / Cut / Take 메타데이터와 파일명 규칙
을 관리할 수 있습니다. First Rush 2.3.0 기준으로 Live Tools 패널은 라이브 컬러 그레이딩, 스코프, 노
출 및 포커스 보조, 실시간 합성, 클립 재생, DeckLink / AJA 처리 SDI 프로그램 아웃, SDI 라우팅 패치
베이를 함께 제공합니다.

이 매뉴얼의 스크린샷은 실제 촬영 현장이 아니라 목(mock) 소스로 캡처한 것이므로, 일부 화면 텍스트가
시스템 언어와 무관하게 영어로 표시됩니다. 기능의 위치와 워크플로는 동일합니다. 실제 카메라를 연결하
면 프리뷰, 타임코드, 오디오, SDI 메타데이터가 사용 중인 하드웨어와 신호에 맞춰 표시됩니다.
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요구 사항

First Rush를 사용하려면 Apple Silicon Mac과 캡처 하드웨어용 제조사 드라이버가 필요합니다.

지원되는 캡처 디바이스 제품군:

Blackmagic Design DeckLink / UltraStudio.

AJA 디바이스.

현장 투입 전 권장 사항:

Blackmagic Desktop Video 또는 AJA Desktop Software를 먼저 설치하세요.

캡처 디바이스가 제조사 유틸리티에서 인식되는지 확인하세요.

카메라 영상, 임베디드 오디오, 타임코드가 캡처 디바이스까지 정상적으로 들어오는지 확인하세요.

ProRes 녹화에 충분한 저장 공간을 확보하세요.

첫 테이크 전에 반드시 짧은 테스트 녹화를 진행하세요.
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설치, 라이선스 및 업데이트

1. 최신 First Rush DMG를 다운로드합니다.

2. DMG를 열고 First Rush를 응용 프로그램 폴더로 드래그합니다.

3. First Rush를 실행합니다.

4. macOS가 묻는 카메라 / 오디오 접근 권한을 허용합니다. 이 권한은 Mac 내장 카메라가 아니라 캡처 카드 입
력을 받기 위한 것입니다.

First Rush는 Apple 공증(notarized)을 받은 빌드이므로 첫 실행 시 Gatekeeper에 막히지 않고 열립니다. "확인
되지 않은 개발자(unidentified developer)" 경고가 나타난다면 전송 도중 DMG가 손상되었을 가능성이 높으니,
다시 다운로드해서 설치하세요.

구독 및 무료 체험

First Rush는 구독제입니다. 첫 실행 시 라이선스 시트가 나타납니다.

Start free trial: First Rush 스토어를 통해 7일 무료 체험을 시작합니다. 체험판에서는 앱의 모든 기능이 잠
금 해제되며, 메뉴 막대와 라이선스 시트에 남은 기간이 카운트다운으로 표시됩니다.

Enter license key: 구매 이메일에 담긴 키를 붙여넣어 활성화합니다. 키는 Mac 한 대에 종속되며, 라이선
스 시트에서 비활성화 / 재활성화하여 다른 Mac으로 옮길 수 있습니다.

현재 직접 구매 구독은 단일 플랜입니다 — 모든 기능 포함 월 ₩20,000 또는 연 ₩200,000이며, 표시 가격은 부
가세(VAT) 별도입니다. Mac App Store 구독은 Apple 수수료 구조 때문에 월 / 연 각각 ₩1,000 더 높게 표시될
수 있습니다.

체험이나 구독이 만료되면 녹화가 잠기고 시트가 다시 나타납니다. 이 상태에서도 신호 진단과 Activity Log는 계속
사용할 수 있습니다. 라이선스 정보를 확인하거나 다른 Mac으로 옮기려면 First Rush > License… 를 사용
하세요.

Sparkle 자동 업데이트

직접 다운로드한 DMG 빌드는 Sparkle 프레임워크를 통해 자동으로 업데이트됩니다.

실행 직후 EdDSA로 서명된 appcast.xml 을 폴링합니다.

새 빌드가 있으면 업데이트 시트가 나타납니다. Install Update를 누르면 다운로드, 검증, 설치, 재실행이 한
번에 진행됩니다.

First Rush > Check for Updates… 에서 수동으로 확인할 수 있습니다.
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외부와 단절된 현장 네트워크에서는 업데이트를 무시해도 무방합니다 — 기존 빌드가 그대로 작동합니다.

Mac App Store 빌드는 Sparkle 대신 App Store를 통해 업데이트됩니다.
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메인 윈도우

메인 윈도우는 다음 영역으로 구성됩니다:

왼쪽 소스 사이드바: 카메라 / 캡처 입력 목록.

가운데 뷰어 그리드: 프리뷰, 녹화 상태, 타임코드, 오디오 미터, 소스 오버레이.

오른쪽 인스펙터: 메타데이터, SDI 진단, 프리뷰 이펙트, LUT, 데스티네이션 할당, 자동 녹화 설정.

하단 슬레이트 스트립: Scene / Cut / Take 입력과 슬레이트 모드.

하단 갱(gang) 컨트롤 바: 선택된 소스 또는 활성 소스에 대한 녹화 / 정지 제어.

Live Tools 패널: Color, Monitor, Composite, Playback, SDI Out을 모아 둔 도킹형 하단 패널.
Option-Command-G  또는 View 메뉴에서 토글합니다.

오른쪽 상단 툴바에서 레이아웃, VU 미터, 타임코드 표시, 정보 오버레이, 슬레이트 스트립, Activity Log, 인스펙터
를 켜고 끌 수 있습니다.

Layout 메뉴

뷰어 그리드 배열은 Layout  메뉴 또는 툴바의 레이아웃 버튼에서 변경합니다.
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Layout 메뉴

Auto Layout : 활성 소스 수에 맞춰 그리드를 자동으로 조정합니다.

Single  / 2 x 1  / 2 x 2 (4)  / 3 x 3 (9)  / 4 x 4 (16) : 고정 그리드.

Primary + Right Strip : 메인 뷰 하나에 썸네일 스트립을 더한 배치.

Enable Portrait Mode (CW 90°)  / Cycle Portrait Mode : 세로 / 9:16 모니터링.

Toggle Fullscreen : 현재 뷰어를 전체 화면으로 전환합니다.

Auto Layout은 소스 수가 자주 바뀌는 현장에 적합하고, Primary + Strip은 특정 카메라 하나를 우선으로 모니터
링할 때 가장 좋습니다.
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소스

캡처 소스를 보려면 왼쪽 사이드바의 Cameras  탭을 엽니다.

Cameras 탭

각 소스 행에는 하드웨어 백엔드(Blackmagic 또는 AJA), 소스 이름, 신호 / 동작 / 녹화 상태, 활성화 스위치가 표
시됩니다. 녹화 전에 소스를 켜세요. "No signal"이 표시되면 카메라 출력 포맷, 케이블 연결, 캡처 카드 입력 라우
팅, 드라이버 상태를 차례로 점검하세요.

소스 설정

소스를 선택한 뒤 사이드바 하단의 기어 버튼을 누르거나, 뷰어 타일의 메타데이터 태그 버튼을 눌러 Source
Settings를 엽니다.
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소스 설정

Source name: UI에 표시되는 이름.

Clip metadata: Scene, Take / Shot, Reel / Tape, Reel #, Camera make / model, Camera label,
Director, DP, Production, Notes. 이 정보는 QuickTime 사용자 데이터로 녹화 파일에 기록되며, Final
Cut Pro와 DaVinci Resolve에서 Tape / Scene / Shot 열을 자동으로 채워 줍니다.

Video settings: 입력 포맷(자동 감지 권장), AJA 하이브리드 입력의 SDI / HDMI 선택, 풀게이트(full-
gate) 크롭.

SDI port direction: 출력이 가능한 DeckLink / AJA 커넥터는 입력에서 출력으로 전환할 수 있습니다. 녹
화 중이거나 Clip Playout이 사용 중일 때는 안전을 위해 잠깁니다.

Audio settings: 채널 수, 비트 심도, 위상 반전, 오디오 딜레이(-30~+30프레임), 채널 매핑, 오디오 소스.

Pre-Record buffer: 녹화 버튼을 누르기 전 최근 0~30초를 메모리에 보관했다가 클립 앞부분에 함께 기록
합니다.

Timecode / Auto-record trigger: 타임코드 소스(SDI Embedded, Audio LTC, Mac Clock), REC

Flag (SDI/HDMI) , HDMI TC Run (Beta) , 카메라별 Record Flag 프리셋을 설정합니다.

풀게이트는 오픈게이트 / 아나모픽 촬영에서 프레임 안 HUD나 검정 영역을 피해 실제 기록 영역을 잡는 기능입니
다. Auto Detect 로 경계를 잡은 뒤 좌 / 우 / 상 / 하 인셋을 0~25% 범위에서 조정합니다. 미리보기에는 가이
드로 보이고, 녹화 적용 여부는 데스티네이션 / 프리뷰 효과 설정을 기준으로 판단하세요.
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다중 적용 (Cmd-Click)

여러 카메라를 한 번에 동일한 값으로 설정하려면 사이드바에서 여러 소스를 Cmd-Click 하세요. 선택된 소스가
강조 표시되며, 이후 인스펙터 / 소스 설정에서 변경한 내용이 선택된 모든 소스에 함께 적용됩니다. 이 작업은 되돌
릴 수 없습니다 — 선택된 소스의 기존 값을 덮어쓰므로, 별도 설정이 필요한 소스는 미리 선택을 해제하세요.

소스 간 오디오 라우팅

Audio Source 는 기본적으로 각 소스 자체의 SDI 임베디드 오디오를 사용하지만, 다른 소스의 오디오를 이 소
스의 녹화에 라우팅할 수도 있습니다. 대표적인 현장 사례를 들면, A-cam에는 멀리 떨어진 마이크만 있고 B-cam
이 붐 마이크를 담당하는 경우 A의 Audio Source 를 B로 설정하면 A의 파일에 붐 마이크 오디오가 녹음됩니
다. 라우팅은 다음 클립부터 적용되며, 이미 녹화 중인 클립은 기존 오디오로 마무리됩니다.
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데스티네이션

녹화 데스티네이션은 왼쪽 사이드바의 Records  탭에서 설정합니다. 각 데스티네이션은 폴더, 코덱 프리셋, 파일
명 규칙, 영상 설정, 오디오 트랙 레이아웃, 녹화 후 옵션을 정의합니다. 데스티네이션을 선택한 뒤 기어 버튼을 눌러
Destination Settings를 엽니다.

데스티네이션 설정

데스티네이션에서 설정할 수 있는 주요 항목:

Record effects: 회전, 디인터레이스, 타임코드 번인, 소스 이름 번인, 기존 파일 덮어쓰기.

Loop Recording: 지정한 여유 공간(GB)을 남기면서 오래된 클립을 순환 관리하는 현장용 옵션.

Post Process Script: 녹화 종료 후 지정한 스크립트를 실행하고, 필요하면 Watch Folder로 결과물을 이
동합니다.

Auto Split: 15분 / 30분 / 1시간 / 2시간 / 4시간 또는 2GB / 4GB 단위로 긴 녹화를 자동 분할합니다.

Video: Rec.709, Rec.2020, Rec.2020 PQ / HLG, P3 D65 등 색 공간 메타데이터, H.264 프로파일,
H.264 / HEVC 비트레이트를 지정합니다.

Audio Tracks: 트랙 이름, 채널 수(1 / 2 / 4 / 6 / 8), 언어 코드, 입력 채널 매핑을 데스티네이션별로 구성합
니다.
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파일 이름 지정

토큰 팔레트로 파일 이름을 구성합니다. 예:

S  + Scene  + _C  + Shot  + _T  + Take(auto)  + -  + CamLabel  -> S15_C02_T01-

A.mov

Preview 행에 다음에 생성될 파일 이름이 미리 표시됩니다.

프리셋 메뉴에는 날짜_시각_소스, 카메라 라벨, Slate 스타일, 씬_컷_테이크-카메라, ARRI 카메라 릴, ARRI 릴+슬
레이트, 테스트 클립 포맷이 들어 있습니다. 토큰 팔레트에는 Year / Month / Day / Timecode / SourceName /
DestinationName / Reel / Round / ClipName / Scene / Shot / Take / CamLabel / Episode 등이 있으며,
/  리터럴을 쓰면 폴더 단계로도 활용할 수 있습니다.

코덱 프리셋

ProRes 422 Proxy: 현장 편집용 경량 프록시.

ProRes 422 / HQ 이상: 편집 또는 포스트 납품용 고화질.

DNxHR / H.264 / HEVC: 빌드와 데스티네이션에서 활성화된 경우 사용 가능.

현장 편집용으로는 ProRes 422 Proxy가 가장 무난한 기본값입니다.
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슬레이트 스트립

하단 슬레이트 스트립은 Scene / Cut / Take 값을 여러 소스에 한 번에 적용합니다.

모드: Film, Drama(에피소드 접두사), Reel(카메라 릴 / 클립 이름), Test(별도 카운터), Custom(자유 형식).
Scene / Cut / Take 값을 입력하면 현재 슬레이트가 소스 메타데이터와 다음 클립 파일명에 즉시 반영됩니다.
Auto +Take 를 켜면 한 녹화 사이클이 끝난 뒤 다음 Take로 자동 증가합니다.

Auto Folder 를 켜면 데스티네이션 폴더 아래에 회차 / 날짜 / Scene / Reel / Episode 기반 폴더를 자동 생
성해 녹화물을 분류합니다. 폴더 아이콘의 설정 버튼에서 현재 슬레이트 모드별 폴더 템플릿을 편집할 수 있고,
Round  값은 자정을 넘는 밤샘 촬영도 같은 회차 폴더로 묶는 기준점이 됩니다.
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녹화

수동 녹화

하단 컨트롤 바로 제어합니다 — REC 로 시작하고 STOP 으로 정지합니다 — 또는 Recording 메뉴의
Record All  / Stop All 로 선택된 소스나 활성 소스 전체를 한 번에 제어합니다.

단축키: Command-R  Record All, Command-K  Stop All, Command-P  Pause All, Shift-Command-

P  Resume All, Command-M  챕터 마커 삽입.

챕터 마커

녹화 중에 Command-M 을 누르면 현재 타임코드 위치에 챕터 마커가 추가됩니다.

마커는 모든 활성 클립에 한 번에 적용됩니다(갱 마커).

마커는 녹화 .mov  안에 QuickTime 챕터 트랙으로 직접 기록되므로, 별도의 내보내기 단계 없이 Final
Cut Pro와 DaVinci Resolve에서 챕터 / 마커로 그대로 열립니다.

마커에는 자동으로 레이블이 붙으며( Marker 01 , Marker 02 …), 필요하면 편집 프로그램에서 이름을
변경하세요.

마커 이벤트는 Activity Log에도 기록됩니다.

스틸 프레임

Recording > Save Still ( Shift-Command-S )은 선택된 소스의 스틸을 저장하고, Save Stills

(All Cameras) 는 모든 활성 소스를 한 번에 캡처합니다. 스틸은 현재 프로세싱된 이미지를 기준으로 베이크됩
니다.

Preferences > General > Still Capture 에서 저장 폴더, 포맷(PNG / JPEG / TIFF), 그레이드 베이
크(CDL+LUT), 룩 사이드카(ACES AMF + ASC CDL)를 정합니다. 저장 폴더를 비워 두면 각 데스티네이션 폴더
아래 Stills  폴더를 사용합니다.

자동 녹화

소스별 Auto record는 인스펙터에서 켭니다. 자동 녹화가 작동하려면 소스에 데스티네이션이 하나 이상 할당되어
있어야 합니다.
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자동 녹화 트리거 설정

두 가지 트리거 모드가 있습니다:

REC Flag (SDI/HDMI) : 기본이자 가장 안정적인 방식 — DeckLink 녹화 트리거 플래그 또는 AJA
RP188 녹화 플래그를 사용합니다.

HDMI TC Run (Beta) : DeckLink-HDMI 보조 방식 — 타임코드가 흐르기 시작하면 녹화가 시작되고,
멈추면 정지합니다.

SDI 카메라는 REC Flag 를 그대로 사용하세요. HDMI로 연결한 Sony 미러리스의 경우 HDMI Time Code
Output: On, REC Control: On, TC Run: Rec Run으로 설정하세요.
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메타데이터 및 자동 채우기

First Rush는 클립 메타데이터를 녹화 파일에 기록하며, 같은 필드를 인스펙터에서 직접 편집할 수 있습니다:
Scene, Cut / Shot, Take, Reel / Tape, Reel number, Clip name, Camera make / model, Camera label,
Notes.

SDI 카메라 정보 영역은 VANC / ANC 패킷과 HUD OCR에서 카메라 데이터를 읽어 들입니다. 지원되는 신호에
서는 Reel, Clip name, ISO, White Balance, Shutter, Lens를 자동으로 채울 수 있습니다.

진단 칩: TC  타임코드 감지, REC  녹화 플래그 감지, ANC  보조(ancillary) 메타데이터 감지, Audio  임베
디드 오디오 상태, OCR  HUD OCR 상태. 자동 채우기가 작동하지 않을 때는 이 칩들부터 확인하세요.

HUD OCR

ANC에 메타데이터를 싣지 않는 카메라(상당수의 미러리스 및 일부 시네마 카메라 HDMI 출력)의 경우, First Rush
는 OCR로 화면의 HUD를 읽습니다 — Reel 이름, Clip 이름, ISO / EI, Shutter, White Balance / Tint, 호환되
는 Lens 데이터를 인식합니다. HUD 영역을 1~2초마다 샘플링하고, 제조사별 레이아웃(ARRI / RED / Sony /
Blackmagic)에 맞춰 분석한 뒤, Vision 프레임워크로 텍스트를 인식하고, Auto-fill 이 켜져 있으면 인식에
성공한 값만 채웁니다.

가장 좋은 결과를 얻으려면 HUD가 프레임에 선명하게 보여야 합니다. 강한 모니터링 LUT나 다운컨버터는 OCR
정확도를 떨어뜨릴 수 있습니다. Help > Export SDI Diagnostic… 에는 OCR 시도 / 성공 횟수가 포함되
므로, 인식이 잘 되지 않을 때 함께 첨부하세요.
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프리뷰 이펙트 및 LUT

인스펙터의 프리뷰 / 녹화 이펙트 섹션에서는 프리뷰 보정과 가이드를 설정합니다: Auto crop, Keep HUD
metadata, Grid, Letterbox, Rotation, Flip H / V, Center Cross, Preview LUT. 이들은 기본적으로 프리뷰에
만 적용됩니다. 파일에 베이크하려면 Apply to recording 을 켜세요.

Keep HUD metadata 는 스케일 / 크롭 중에도 카메라 HUD 영역을 가장자리에 고정해 메타데이터 확인성을
높입니다. Auto crop 은 검정 bar나 빨간 safe-frame 경계를 다시 감지하고, Grid는 thirds / fifths /
crosshair 가이드로 사용할 수 있습니다.

종횡비 및 세이프 프레임

Letterbox / Pillarbox 가이드: 16:9 신호 위에 2.35:1, 2.39:1, 2:1 또는 4:3 가이드를 오버레이하여 프레
이밍 참고용으로 사용합니다(프리뷰 전용).

Portrait / 9:16: Reels / Shorts용으로 Portrait Mode를 켜고 9:16 크롭을 드래그해 피사체를 따라가게
한 뒤, Apply to recording 을 켜면 크롭된 프레임이 녹화됩니다. Cycle Portrait Mode 는

16:9 -> 9:16 -> 9:16 (left) -> 9:16 (right) 순으로 순환합니다.

3D LUT 프리뷰 (.cube)

Preview LUT 영역에서 Pick LUT… 를 열고 .cube  파일(Rec.709 변환용, 룩 LUT 또는 카메라 LUT)을 선
택하면 프리뷰에 즉시 적용됩니다. 슬라이더로 강도를 조정하세요. Apply to recording 을 켜서 LUT를 베이
크하거나, 깨끗한 LOG 마스터는 그대로 두고 LUT를 베이크한 별도의 프록시 데스티네이션을 따로 만들 수도 있습
니다. 17 / 33 / 65 큐브 LUT를 지원합니다.



60

장  1 0

Live Tools — 컬러 및 스코프

Live Tools 패널( Option-Command-G )을 열고 Color 탭을 선택합니다. 패널 헤더에서 그레이딩할 소스를 선택
하세요.

Live Tools — 컬러 및 스코프

컬러 휠

Lift, Gamma, Gain, Offset 휠로 1차(primary) 그레이딩을 합니다:

디스크 안을 드래그하여 컬러 밸런스를 잡습니다(상대 트랙볼 방식).

각 휠 아래의 슬라이더는 마스터(레벨) 컨트롤입니다.

디스크를 더블 클릭하면 해당 밸런스가 초기화됩니다.

이 그레이딩은 ASC CDL 연산으로 처리되므로 깔끔하게 라운드트립됩니다. Export .cdl  / Load .cdl
로 그레이딩을 주고받고, Save Look  / Looks 로 룩을 저장하거나 불러오며, Copy  / Paste 로 소스 간
에 그레이딩을 옮길 수 있습니다.
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CDL, LUT 및 뷰 모드

CDL (ASC)  토글은 CDL 그레이딩을 켭니다.

Pick LUT… 는 그레이딩 위에 .cube  LUT를 얹어 불러옵니다.

Graded  / LUT only  / Original  버튼은 뷰어에 표시되는 내용을 전환하여 그레이딩 적용 결과,
LUT 단독, 손대지 않은 원본 소스를 비교할 수 있게 해 줍니다.

Sat  슬라이더는 채도를 조정합니다.

Bake into recording (CDL -> LUT) 는 깨끗한 원본 대신 그레이딩된 이미지를 녹화합니다.

스코프

패널 오른쪽에는 라이브 스코프가 표시됩니다 — Waveform, RGB Parade, RGB Overlay, Vectorscope,
Histogram, Chromaticity. 스코프를 클릭하면 크기 조절이 가능한 별도 윈도우로 열립니다. 스코프는 정확한 판독
을 위해 선택된 모니터링 색 공간(Rec.709 / Rec.2020 / P3 / Rec.601)을 따르며, HDR 모니터링도 지원합니다.
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Live Tools — 노출 및 포커스 보조

Live Tools에서 Monitor 탭을 선택합니다. 이 보조 기능들은 프리뷰 전용이라 녹화, SDI 출력, 스코프에는 영향을
주지 않습니다.

Live Tools — 노출 및 포커스 보조

False Color: 노출 구간을 색상으로 매핑하여 노출을 한눈에 잡을 수 있게 해 줍니다.

Zebra: 하이라이트 클리핑 영역을 줄무늬로 표시합니다.

Peaking: 초점이 맞은 가장자리를 강조하여 정밀하게 초점을 확인할 수 있게 해 줍니다.
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Live Tools — 합성

Composite 탭을 선택하면 소스를 플레이트와 실시간으로 합성할 수 있습니다 — 그린스크린 모니터링과 현장 프
리비스에 유용합니다.

Live Tools — 합성

Plate: 합성에 사용할 배경 소스 / 이미지를 선택합니다.

Chroma key: similarity, smoothness, 외곽 다듬기(edge choke), 스필 제거(spill suppression)로 그린
/ 블루를 키 아웃합니다. Show Matte 로 매트를 미리 보며 조정하세요.

Mix, Wipe, Diff: 비교 및 오버레이용 블렌드 모드. 와이프는 각도와 페더를 조정할 수 있습니다.

Draw Mask: 합성 영역을 프레임 일부로 제한하는 타원 / 사각형 매트(위치, 크기, 페더, 반전).

Composite Monitor: 합성 결과를 뷰어 그리드의 가상 타일(또는 별도 윈도우)로 표시하여 메인 타일은 깨
끗하게 유지합니다.

Bake composite into recording: 합성된 이미지를 녹화합니다. 기본적으로 꺼져 있어 마스터는 깨끗하
게 유지됩니다.
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Live Tools — 클립 재생

Playback 탭을 선택하면 First Rush를 벗어나지 않고 녹화된 클립을 검토하거나 파일을 열 수 있습니다.

Live Tools — 클립 재생

녹화된 클립이 클립 목록에 나타납니다. Play File… 로는 모든 영상 파일을 열 수 있습니다.

트랜스포트 컨트롤로 재생 / 일시정지, 프레임 단위 이동, 스크럽, 속도를 제어합니다. 플레이어 창에서는
Space(재생 / 일시정지), ← / →(1프레임 이동), J / K / L(역재생 / 정지 / 정방향), I / O(IN / OUT)를 사용할
수 있습니다.

SDI 출력 하드웨어가 있으면 재생 화면을 모니터로 내보낼 수 있고, 없으면 First Rush가 인앱 플레이어로 대
체하여 Mac에서 바로 검토할 수 있습니다.

하드웨어 SDI 플레이아웃을 쓰려면 SDI Out 탭 또는 Preferences > SDI Routing에서 출력 포트를
Clip Playout으로 지정하세요. 2.3.0에서는 출력 지정과 게이팅이 정리되어, 클립 플레이아웃이 출력 카드를
사용하는 동안 같은 카드의 Program Out이 충돌하지 않도록 자동으로 보호됩니다.

클립 목록은 세션 단위로 유지되며 앱을 재시작하면 초기화됩니다. 새로고침 컨트롤로 다시 스캔하고, 행 컨텍스트
메뉴로 항목을 제거하세요(원본 파일은 그대로 유지됩니다).
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Live Tools — SDI 프로그램 아웃

SDI Out 탭을 선택하면 소스를 SDI 출력 커넥터로 미러링할 수 있습니다.

Live Tools — SDI 프로그램 아웃

Program out (mirror this source to SDI output): 소스를 출력용 카드 커넥터로 내보냅니다.

Processed — grade, composite, rotation applied to output: 끄면 출력이 깨끗한 피드(원본 입력
미러)가 되고, 켜면 SDI 출력에 프리뷰에서 보는 것과 동일한 그레이딩, 합성, 회전이 적용됩니다. 2.3.0부터
이 처리 출력은 DeckLink뿐 아니라 지원되는 AJA SDI 출력에도 적용됩니다.

AJA 출력은 HD / 2K progressive 워크플로를 기준으로 동작하며, 2.3.0에서 프리런 카메라 사용 시 화면이
위로 흐르던 출력 롤업 문제가 안정화되었습니다.

프로그램 아웃을 사용하려면 출력으로 설정된 카드 커넥터가 필요합니다 — SDI Out 탭 또는 Preferences >
SDI Routing을 참고하세요.
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외부 모니터 (AVOut)

External Monitor  메뉴는 감독 및 클라이언트 디스플레이용으로, 메인 윈도우와는 별개인 전체 화면 모니터
링 윈도우를 엽니다.

Add AVOut Window : 새 출력 윈도우를 엽니다. 원하는 디스플레이에 배치하고 표시할 소스를 선택하세
요.

Close All AVOut Windows : 모든 출력 윈도우를 닫습니다.

AVOut 윈도우는 모니터링 전용입니다 — 녹화는 언제나 메인 데스티네이션이 담당합니다. 네 대 이상을 동시에 녹
화할 때는 안정성을 위해 AVOut 윈도우를 단일 소스로 유지하세요.
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Companion Viewer (iPhone / iPad)

Companion Viewer는 같은 로컬 네트워크를 통해, 또는 현장에 라우터가 없을 때는 직접(P2P) 연결로 iPhone이
나 iPad에 모니터링 프리뷰를 스트리밍합니다. 뷰어는 모니터링 전용이며 절대 녹화하지 않습니다.

Companion Viewer > Companion Viewer… ( Command-Option-V )를 엽니다.

Companion Viewer 패널

뷰어 앱 설치

First Rush Viewer는 무료 iPhone / iPad 앱입니다 — App Store에서 "First Rush Viewer"를 검색하세요.
iOS / iPadOS 17 이상과 로컬 네트워크 권한(첫 실행 시 요청)이 필요하며, 카메라 권한은 QR 페어링에만 사용됩
니다.

연결

1. Mac에서 Companion Viewer 패널을 열고 서버를 시작합니다 — Create Pairing Code 를 누르면
서버 시작과 코드 발급이 한 번에 이루어집니다.

2. 6자리 코드와 QR 코드가 표시됩니다.
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3. 기기에서 First Rush Viewer를 엽니다. Mac이 자동으로 검색됩니다.

4. Mac을 선택한 뒤 6자리 코드를 입력하거나 QR 코드를 스캔합니다.

5. 레이아웃( 1 Cam – 4 Cam )과 표시할 카메라를 선택합니다.

Mac은 Bonjour로 같은 로컬 네트워크의 Viewer 앱에 표시됩니다. 코드는 5분간 유효하고 여러 기기를 페어링할
수 있으며, 한 번 페어링한 기기는 자동으로 재연결됩니다. 서버나 앱을 재시작하면 페어링이 초기화되므로 새 코드
를 발급하세요.

라우터 없이 (P2P)

공유 Wi-Fi가 없으면 Mac과 기기가 직접 연결됩니다(Mac First Rush 2.0.1 이상, Viewer 2.0 이상). 별도 설정이
필요 없으며, 대역폭 보호를 위해 P2P 연결에서는 화질이 자동으로 제한됩니다 — 더 높은 화질이 필요하면 공유
Wi-Fi를 사용하세요.

보안 및 제한

녹화는 언제나 Mac에서 이루어지며, 뷰어에는 VIEW ONLY 가 표시됩니다.

6자리 코드 없이는 연결할 수 없습니다.

화면 녹화나 미러링이 감지되면 이미지가 가려지고 Screen Capture Protected 가 표시됩니다.

영상만 전송됩니다 — 오디오와 타임코드는 전송되지 않습니다.

Mac의 라이브 컬러 / 합성은 컴패니언 스트림에 적용되지 않으며, 원본 카메라 이미지가 그대로 전송됩니다.
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현장 제어 및 원격 보조

인스펙터에는 현장 제어용 보조 기능이 모여 있습니다.

Stream Deck: Elgato Stream Deck을 USB로 연결해 버튼별 동작을 지정합니다. HID 연결을 켜면 앱이
장치를 탐색하고, 각 버튼에 Record / Stop / Pause / Take / Marker 계열 동작을 매핑할 수 있습니다.

Network Sync: 여러 Mac을 Leader / Follower로 나누어 동기화하는 현장용 옵션입니다. 한 대를
Leader로 두고 나머지를 Follower로 두면 원격 세션 상태를 맞추는 데 사용할 수 있습니다.

Web Remote: 같은 LAN의 브라우저에서 http://<이-Mac-IP>:포트  주소로 접근해 기본 원격 조작
을 할 수 있습니다. 현장 네트워크에서만 쓰고, 외부 인터넷에 노출하지 마세요.
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Activity Log 및 진단

View > Activity Log 를 엽니다.

활동 및 로그

Activity & Logs 윈도우는 CPU, 메모리, 여유 디스크 용량, 진행 중인 녹화와 함께 소스 및 녹화 이벤트를 표시하
며, 검색, 지우기, 내보내기를 지원합니다. 신호 문제를 보고할 때는 Help 메뉴의 Copy SDI Diagnostic ,
Export SDI Diagnostic… , Email SDI Diagnostic… 을 사용하세요. 진단 정보에는 앱 버전, 신호 포
맷, 타임코드, 녹화 플래그, 오디오 채널, 최근 ANC 요약, OCR 시도 / 성공 횟수, 메타데이터 소스 상태가 포함됩니
다.
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환경설정

Command-, 로 환경설정을 엽니다. 탭은 네 개입니다.

환경설정 — General

General: 언어(macOS 시스템 언어를 따름), 기본 뷰어 레이아웃, 기본 패널, 시스템 대시보드, 소스 사이드
바, 인스펙터, 슬레이트 바, Live Tools 패널에 대한 Display / Panels 토글. 같은 탭에서 Still Capture와 설
정 초기화도 관리합니다.

Still Capture: 저장 폴더, PNG / JPEG / TIFF 포맷, 그레이드 베이크, AMF/CDL 룩 사이드카를 설정합
니다.

Reset Settings: 창 / 프리뷰, Slate, 앱 기본 설정을 초기화합니다. 라이선스, 데스티네이션, 소스별 녹화
프리셋은 지우지 않습니다.

Shortcuts: Wacom 태블릿의 ExpressKeys를 First Rush 동작에 매핑합니다 — F13 Record all, F14
Stop all, F15 Pause, F16 Take +, F17 Take −, F18 Chapter marker, F19 Select all sources — 일
반 키보드 대체 단축키로 Command-R  / Command-K  / Command-M 을 제공합니다.
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환경설정 — Shortcuts

SDI Routing: 카드별로 각 커넥터를 입력 또는 출력으로 지정하고, 출력을 Program Out 또는 클립 플레이
아웃에 매핑합니다. 출력으로 지정한 커넥터는 소스 목록에서 빠지며, 사이드바의 SDI Output Ports 행에서
다시 전환할 수 있습니다. 2.3.0부터 패치베이에서 입력 점을 출력 점으로 드래그해 PGM OUT 연결을 만들
수 있고, 기존처럼 입력 점을 선택한 뒤 출력 점을 클릭해 연결하거나 연결된 출력을 다시 클릭해 해제할 수도
있습니다.
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환경설정 — SDI Routing

License: 구독 / 체험 상태 및 라이선스 관리. 결제 실패 그레이스, 오프라인 그레이스, 만료 상태를 여기에서
확인합니다.
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문제 해결

No signal — 카메라 출력 포맷, 캡처 카드 입력 라우팅, SDI / HDMI 케이블, 제조사 유틸리티에서의 디바이스 인
식 여부, 소스 활성화 여부를 확인하세요.

No audio — 카메라 출력에 임베디드 오디오가 실려 있는지, 그리고 소스 채널 수와 비트 심도, 데스티네이션 오디
오 트랙, 채널 매핑, 음소거 / 마스터 볼륨을 확인하세요.

자동 녹화가 시작되지 않음 — 소스의 Auto record가 켜져 있는지, 데스티네이션이 할당되어 있는지, 트리거 모드,
REC 플래그(SDI) 또는 HDMI TC 설정(Sony), 그리고 Activity Log의 REC  / STBY  / 쿨다운 메시지를 확인
하세요.

메타데이터가 자동으로 채워지지 않음 — TC  / ANC  / OCR  칩, 카메라가 실제로 메타데이터를 내보내고 있
는지, 컨버터 / 무선 / 스위처가 ANC를 제거하고 있지 않은지, HUD를 읽을 수 있는지, Auto-fill이 켜져 있는지 확
인하세요.

파일 이름이 예상과 다름 — 슬레이트 모드, Scene / Cut / Take 값, 데스티네이션 토큰, 카메라 레이블, Auto

+Take  설정을 확인하세요.

스틸이 원하는 폴더에 저장되지 않음 — Preferences > General > Still Capture 의 저장 폴더를 확
인하세요. 비어 있으면 데스티네이션 폴더 아래 Stills 가 기본값입니다.

Viewer 앱에서 Mac이 보이지 않음 — Mac과 iPhone / iPad가 같은 로컬 네트워크에 있는지, Mac에서
Companion Viewer 서버가 켜져 있는지, iOS의 Local Network 권한을 허용했는지 확인하세요.

Help 메뉴의 챗봇이 열리지 않음 — Help > AI Assistant 는 https://editorhan.me/first-

rush/help 를 엽니다. 외부 인터넷이 막힌 현장에서는 열리지 않을 수 있으므로 PDF 매뉴얼을 함께 보관하세요.
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현장 체크리스트

첫 테이크 전: 캡처 디바이스 인식 확인, 모든 소스 표시 확인, 신호·타임코드·오디오 확인, 데스티네이션 폴더 설정,
코덱 프리셋 확인, 파일명 프리뷰 확인, Scene / Cut / Take 설정, 자동 녹화 사용 시 트리거 모드 확인, 짧은 테스
트 녹화를 편집 프로그램에서 열어 보기.

촬영 중: 빨간 녹화 테두리와 REC 타이머 주시, 여유 디스크 공간 주시, Auto +Take 확인, 메타데이터가 중요한 경
우 TC / REC / ANC / Audio / OCR 칩 주시.

설정 변경 후: 신호 포맷, 오디오 채널 매핑, 트리거 모드를 다시 확인하고 짧은 테스트 녹화를 한 번 더 진행하세요.
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키보드 단축키

녹화: Command-R  Record All, Command-K  Stop All, Command-P  Pause All, Shift-Command-P

Resume All, Command-M  챕터 마커, Shift-Command-S  Save Still.

슬레이트 및 메타데이터: Scene / Cut / Take 입력값은 자동 적용됩니다. Command-]  / Command-[  Take
+/−, Shift-Command-]  / Shift-Command-[  Scene +/−, Option-Command-]  / Option-

Command-[  Cut +/−.

선택: Cmd-Click  소스 개별 다중 선택, Shift-Click  범위 선택, Command-A  모든 소스 선택.

뷰 및 레이아웃: Command-1  / 2  / 3  / 4  Single / 2×2 / 3×3 / 4×4, Option-Command-0  Auto
Layout, Command-F  Toggle Fullscreen, Option-Command-S  소스 사이드바, Option-Command-I

인스펙터, Option-Command-L  슬레이트 바, Option-Command-G  Live Tools 패널, Option-

Command-Y  Activity Log.

출력: Command-Option-V  Companion Viewer 패널, Shift-Option-Command-O  AVOut 윈도우 추
가, Shift-Option-Command-W  AVOut 윈도우 모두 닫기.

각 메뉴 항목 옆에 표시된 단축키가 기준입니다. 일부 단축키는 빌드나 macOS 환경에 따라 달라질 수 있습니다.
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메뉴 막대 참조

First Rush

About First Rush (버전 / 빌드 / 빌더), Check for Updates… (Sparkle), Preferences…

( Command-, ), License… , Hide / Quit .

File

New Window , Close .

Edit

표준 macOS 편집 메뉴(Undo / Redo / Cut / Copy / Paste / Select All)로, 슬레이트 및 텍스트 필드에서 사용
됩니다.

View

Show Tab Bar  / Show All Tabs , Toggle Source Sidebar , Toggle

Inspector ( Option-Command-I ), Toggle Slate Bar ( Option-Command-L ), Live Tools

Panel ( Option-Command-G ), Activity Log ( Option-Command-Y ), Enter Full Screen .

Recording

Select All Sources , Record All ( Command-R ), Stop All ( Command-K ), Pause

All ( Command-P ), Resume All ( Shift-Command-P ), Insert Chapter Marker ( Command-

M ), Save Still ( Shift-Command-S ), Save Stills (All Cameras) .
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Recording 메뉴

Layout

Auto Layout , Single , 2 x 1 , 2 x 2 (4) , 3 x 3 (9) , 4 x 4 (16) , Primary +

Right Strip , Enable Portrait Mode (CW 90°) , Cycle Portrait Mode , Toggle

Fullscreen .

External Monitor

Add AVOut Window , Close All AVOut Windows .

Companion Viewer

Companion Viewer… ( Command-Option-V ), Start Companion Viewer , Create Pairing

Code .
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Window

표준 macOS 윈도우 메뉴.

Help

AI Assistant (웹 챗봇), Email Developer , Copy SDI Diagnostic , Export SDI

Diagnostic… , Email SDI Diagnostic… , Bug Report… , Open Activity Log .

메뉴 항목과 단축키는 빌드 / 환경에 따라 다소 달라질 수 있으며, 실제로 화면에 표시되는 메뉴가 기준입니다.
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はじめに

バージョン: First Rush 2.3.0 / build 2300 最終更新日: 2026-06-22

First Rush は macOS 向けのマルチカメラ・オンセットレコーダーです。SDI や対応キャプチャカード
からの入力を編集可能な動画ファイルとして収録し、収録ワークフローの中で Scene / Cut / Take の
メタデータやファイル命名ルールを一元管理できます。First Rush 2.3.0 時点では、Live Tools パネル
にライブカラーグレーディング、スコープ、露出・フォーカス補助、リアルタイム合成、クリップ再生、

DeckLink / AJA 向けの処理済み SDI プログラムアウト、SDI ルーティングのパッチベイが含まれま
す。

本マニュアルのスクリーンショットは、実際の現場ではなくモックソースを用いて撮影しています。その

ため、システム言語にかかわらず画面上の文言が英語で表示される箇所があります。機能の配置やワーク

フローはどの言語でも同一です。実際のカメラを接続すると、プレビュー、タイムコード、オーディオ、

SDI メタデータがお使いのハードウェアと入力信号に応じて表示されます。
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目次

1 必要環境

2 インストール、ライセンス、アップデート

3 メインウィンドウ

4 ソース

5 デスティネーション

6 スレートストリップ

7 収録

8 メタデータと自動入力

9 プレビューエフェクトと LUT

10 Live Tools — カラーとスコープ

11 Live Tools — 露出・フォーカス補助

12 Live Tools — 合成

13 Live Tools — クリップ再生

14 Live Tools — SDI プログラムアウト

15 外部モニター（AVOut）

16 Companion Viewer（iPhone / iPad）
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17 オンセット制御とリモート補助

18 アクティビティログと診断

19 環境設定

20 トラブルシューティング

21 オンセットチェックリスト

22 キーボードショートカット

23 メニューバーリファレンス
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章  1

必要環境

First Rush の動作には、Apple Silicon Mac と、お使いのキャプチャハードウェア用のベンダードライバーが必要
です。

対応キャプチャデバイスファミリー:

Blackmagic Design DeckLink / UltraStudio

AJA デバイス

現場に出る前の推奨事項:

あらかじめ Blackmagic Desktop Video または AJA Desktop Software をインストールしておく。

キャプチャデバイスがベンダー純正ユーティリティで認識されていることを確認する。

カメラの映像、エンベデッドオーディオ、タイムコードがキャプチャデバイスまで届いていることを確認す

る。

ProRes 収録に十分なストレージ容量を確保する。

最初のテイクの前に、必ず短いテスト収録を行う。
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インストール、ライセンス、アップデート

1. 最新の First Rush DMG をダウンロードします。

2. DMG を開き、First Rush をアプリケーションフォルダにドラッグします。

3. First Rush を起動します。

4. macOS から求められたら、カメラ / オーディオへのアクセスを許可します。この許可はキャプチャカードか
らの入力に対するものであり、Mac の内蔵カメラに対するものではありません。

First Rush は Apple の公証（notarize）済みビルドのため、初回起動時に Gatekeeper でブロックされること
なく開きます。「開発元を確認できません」という警告が表示される場合は、転送中に DMG が破損した可能性が高
いため、改めてダウンロードし直してインストールしてください。

サブスクリプションと無料トライアル

First Rush はサブスクリプション制です。初回起動時にライセンスシートが表示されます。

Start free trial: First Rush ストアを通じて 7 日間の無料トライアルを開始します。トライアル中はアプリ
の全機能が利用でき、残り日数のカウントダウンがメニューバーとライセンスシートに表示されます。

Enter license key: 購入確認メールに記載されたキーを貼り付けてアクティベートします。キーは 1 台の
Mac に紐付きます。別の Mac へ移行する場合は、ライセンスシートでディアクティベートしてから再アク
ティベートしてください。

直接購入のサブスクリプションは、全機能を含む単一プランです。月額 ₩20,000、年額 ₩200,000 で、表示価格
は VAT / 消費税別です。Mac App Store 版では Apple の価格体系により、月額 / 年額ともに ₩1,000 高く表
示される場合があります。

トライアルまたはサブスクリプションが失効すると、収録がロックされ、ライセンスシートが再表示されます。こ

の状態でも、信号診断とアクティビティログは引き続き利用できます。ライセンス情報の確認や別の Mac への移
行は、 First Rush > License…  から行います。

Sparkle 自動アップデート

直接ダウンロード版の DMG ビルドは、Sparkle フレームワークを通じて自動的に更新されます。

起動直後に、EdDSA 署名された appcast.xml  を取得します。

新しいビルドがある場合は、アップデートシートが表示されます。Install Update を押すと、ダウンロー
ド、検証、インストール、再起動が一連の流れで自動実行されます。
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First Rush > Check for Updates…  から手動で確認することもできます。

クローズドな現場ネットワークでは、アップデートを見送っても問題ありません。既存のビルドはそのまま動

作し続けます。

Mac App Store 版は App Store 経由で更新され、Sparkle は使用しません。
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章  3

メインウィンドウ

メインウィンドウは、次の領域で構成されています。

左のソースサイドバー: カメラ / キャプチャ入力の一覧。

中央のビューアグリッド: プレビュー、収録状態、タイムコード、オーディオメーター、ソースオーバーレ
イ。

右のインスペクタ: メタデータ、SDI 診断、プレビューエフェクト、LUT、デスティネーション割り当て、自
動収録設定。

下部のスレートストリップ: Scene / Cut / Take の入力とスレートモード。

下部のギャングコントロールバー: 選択中またはアクティブなソースの収録 / 停止コントロール。

Live Tools パネル: Color、Monitor、Composite、Playback、SDI Out をまとめた、ドッキング可能な下
部パネル。 Option-Command-G  または View メニューで表示を切り替えます。

右上のツールバーでは、レイアウト、VU メーター、タイムコード表示、情報オーバーレイ、スレートストリップ、ア
クティビティログ、インスペクタの表示をそれぞれ切り替えられます。

Layout メニュー

ビューアグリッドの配置は、 Layout  メニューまたはツールバーのレイアウトボタンから変更します。
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Layout メニュー

Auto Layout : アクティブなソースの数に合わせてグリッドを自動調整します。

Single  / 2 x 1  / 2 x 2 (4)  / 3 x 3 (9)  / 4 x 4 (16) : 固定グリッド。

Primary + Right Strip : 1 つのメインビューと、その横にサムネイルストリップを表示します。

Enable Portrait Mode (CW 90°)  / Cycle Portrait Mode : 縦位置 / 9:16 モニタリング。

Toggle Fullscreen : 現在のビューアをフルスクリーン表示します。

Auto Layout は、ソース数が頻繁に変わる現場に適しています。Primary + Strip は、特定の 1 台のカメラのモニ
タリングを優先したい場合に最適です。



88

章  4

ソース

左サイドバーの Cameras  タブを開くと、キャプチャソースが一覧表示されます。

Cameras タブ

各ソースの行には、ハードウェアバックエンド（Blackmagic または AJA）、ソース名、信号 / 動作 / 収録の状
態、有効化スイッチが表示されます。収録の前に、まずソースをオンにしてください。「No signal」と表示される場
合は、カメラの出力フォーマット、ケーブル接続、キャプチャカードの入力ルーティング、ドライバーの状態を確認

してください。

ソース設定

ソースを選択してサイドバー下部のギアボタンを押すか、ビューアタイル上のメタデータタグボタンを押すと、

Source Settings が開きます。
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ソース設定

Source name: UI に表示される名前。

Clip metadata: Scene、Take / Shot、Reel / Tape、Reel #、Camera make / model、Camera
label、Director、DP、Production、Notes。これらは QuickTime ユーザーデータとして収録ファイルに
書き込まれ、Final Cut Pro や DaVinci Resolve の Tape / Scene / Shot 列に自動で反映されます。

Video settings: 入力フォーマット（Auto-detect 推奨）、AJA ハイブリッド入力の SDI / HDMI 選択、
フルゲートクロップ。

SDI port direction: 出力可能な DeckLink / AJA コネクタは、入力から出力へ切り替えられます。収録中
または Clip Playout 使用中は、安全のためロックされます。

Audio settings: チャンネル数、ビット深度、位相反転、オーディオディレイ（-30〜+30 フレーム）、チャ
ンネルマッピング、オーディオソース。

Pre-Record buffer: 収録開始前の直近 0〜30 秒をメモリに保持し、収録開始時にクリップの冒頭へ一緒
に記録します。

Timecode / Auto-record trigger: タイムコードソース（SDI Embedded、Audio LTC、Mac
Clock）、 REC Flag (SDI/HDMI) 、 HDMI TC Run (Beta) 、カメラ別 Record Flag プリセット
を設定します。

フルゲートは、オープンゲート / アナモフィック撮影で、信号内の HUD や黒帯を避けて実際の記録領域を決める
ための機能です。 Auto Detect  で境界を検出し、左 / 右 / 上 / 下のインセットを 0〜25% の範囲で調整しま
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す。プレビュー上ではガイドとして表示され、実際の収録への反映はデスティネーション / プレビューエフェクト
側の記録設定に従います。

一括適用（Cmd-Click）

複数のカメラに同じ値を一度に設定するには、サイドバーで対象のソースを Cmd-Click  で複数選択します。
選択中のソースがハイライト表示され、その状態でインスペクタや Source Settings に加えた変更が、選択中の
すべてのソースに適用されます。この操作は上書き（破壊的）です。選択中のソースの既存の値は置き換えられる

ため、個別の設定が必要なソースはあらかじめ選択を解除してください。

ソース間オーディオルーティング

Audio Source  は既定では各ソース自身の SDI エンベデッドオーディオですが、別のソースのオーディオをこ
のソースの収録へルーティングすることもできます。現場での典型例として、A カメラには遠いマイクしかなく、B
カメラがブームを担っている場合、A の Audio Source  を B に設定すると、A のファイルにブームの音声が
収録されます。ルーティングは次のクリップから有効になり、すでに収録中のクリップは自身のオーディオのまま

完了します。
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章  5

デスティネーション

収録先は、左サイドバーの Records  タブで設定します。各デスティネーションには、フォルダ、コーデックプ
リセット、ファイル命名ルール、ビデオ設定、オーディオトラックレイアウト、収録後オプションを定義します。デ

スティネーションを選択してギアボタンを押すと、Destination Settings が開きます。

デスティネーション設定

デスティネーションで設定できる主な項目:

Record effects: 回転、デインターレース、タイムコード焼き込み、ソース名焼き込み、既存ファイルの上
書き。

Loop Recording: 指定した空き容量（GB）を残しながら古いクリップを循環管理する現場向けオプショ
ン。

Post Process Script: 収録終了後に指定したスクリプトを実行し、必要に応じて Watch Folder へ結果
を移動します。

Auto Split: 長時間収録を 15分 / 30分 / 1時間 / 2時間 / 4時間、または 2GB / 4GB 単位で自動分割しま
す。

Video: Rec.709、Rec.2020、Rec.2020 PQ / HLG、P3 D65 などの色空間メタデータ、H.264 プロファ
イル、H.264 / HEVC ビットレートを設定します。
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Audio Tracks: トラック名、チャンネル数（1 / 2 / 4 / 6 / 8）、言語コード、入力チャンネルマッピングを
デスティネーションごとに構成します。

ファイル命名

トークンパレットを使ってファイル名を組み立てます。例:

S  + Scene  + _C  + Shot  + _T  + Take(auto)  + -  + CamLabel  -> S15_C02_T01-

A.mov

Preview の行には、次に生成されるファイル名が表示されます。

プリセットメニューには、日付_時刻_ソース、カメララベル、Slate スタイル、Scene_Cut_Take-Cam、ARRI カ
メラリール、ARRI リール+スレート、テストクリップの形式があります。トークンパレットには Year / Month /
Day / Timecode / SourceName / DestinationName / Reel / Round / ClipName / Scene / Shot / Take /
CamLabel / Episode があり、 /  リテラルを使うとフォルダ階層としても利用できます。

コーデックプリセット

ProRes 422 Proxy: オンセット編集向けの軽量プロキシ。

ProRes 422 / HQ 以上: 編集やポスト納品向けの高画質。

DNxHR / H.264 / HEVC: ビルドとデスティネーションで有効化されている場合に選択できます。

オンセット編集では、ProRes 422 Proxy が最も無難な既定値です。



93

章  6

スレートストリップ

下部のスレートストリップでは、Scene / Cut / Take の値を複数のソースに一括で適用できます。

モード: Film、Drama（エピソードプレフィックス付き）、Reel（カメラリール / クリップ名）、Test（独立カウ
ンター）、Custom（自由形式）。Scene / Cut / Take を編集すると、現在のスレートがソースメタデータと次の
クリップ名へ即座に反映されます。 Auto +Take  をオンにすると、1つの収録サイクルが終わった後に次の
Take へ自動で進みます。

Auto Folder  をオンにすると、デスティネーションフォルダの下に、話数 / 日付 / Scene / Reel / Episode
を使ったフォルダを自動作成し、録画ファイルを分類します。フォルダアイコンの設定ボタンから、現在のスレート

モードごとのフォルダテンプレートを編集できます。 Round  の値は撮影日の基準点にもなるため、深夜 0 時をま
たぐ撮影でも同じ話数フォルダにまとめられます。
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章  7

収録

手動収録

下部のコントロールバーを使用します。 REC  で開始、 STOP  で停止します。または、Recording メニューの
Record All  / Stop All  で、選択中またはアクティブなすべてのソースをまとめて操作できます。

ショートカット: Command-R  Record All、 Command-K  Stop All、 Command-P  Pause All、 Shift-

Command-P  Resume All、 Command-M  チャプターマーカー挿入。

チャプターマーカー

収録中に Command-M  を押すと、現在のタイムコードにチャプターマーカーを打てます。

マーカーは、アクティブなすべてのクリップに同時に打たれます（ギャングマーカー）。

マーカーは QuickTime チャプタートラックとして収録 .mov  に直接書き込まれるため、別途書き出すこ
となく、Final Cut Pro や DaVinci Resolve でチャプター / マーカーとして読み込めます。

マーカーには自動でラベルが付きます（ Marker 01 、 Marker 02  …）。必要に応じて編集アプリ側
で名前を変更してください。

マーカーのイベントはアクティビティログにも記録されます。

スチルフレーム

Recording > Save Still （ Shift-Command-S ）は、選択中のソースからスチルを保存します。

Save Stills (All Cameras)  は、アクティブなすべてのソースを一度にキャプチャします。スチルは、現
在の処理済み画像から焼き込まれます。

Preferences > General > Still Capture  では、保存フォルダ、形式（PNG / JPEG / TIFF）、グレ
ード焼き込み（CDL+LUT）、ルックサイドカー（ACES AMF + ASC CDL）を設定できます。保存フォルダを
空にしておくと、各デスティネーションフォルダ内の Stills  フォルダが使われます。

自動収録

インスペクタで、ソースごとに Auto record をオンにします。自動収録を機能させるには、そのソースに少なくと
も 1 つのデスティネーションを割り当てておく必要があります。
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自動収録トリガー設定

トリガーモードは 2 種類あります。

REC Flag (SDI/HDMI) : 既定の安定した方式。DeckLink のレコードトリガーフラグ、または AJA
RP188 のレコードフラグを使用します。

HDMI TC Run (Beta) : DeckLink-HDMI 向けの補助モード。タイムコードが進み始めると収録を開
始し、止まると停止します。

SDI カメラでは REC Flag  のままにしてください。HDMI 接続の Sony ミラーレスの場合は、HDMI Time
Code Output: On、REC Control: On、TC Run: Rec Run に設定します。
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章  8

メタデータと自動入力

First Rush はクリップメタデータを収録ファイルに書き込みます。同じフィールドはインスペクタで編集できま
す: Scene、Cut / Shot、Take、Reel / Tape、Reel 番号、Clip name、Camera make / model、Camera
label、Notes。

SDI カメラ情報エリアは、VANC / ANC パケットと HUD OCR からカメラデータを読み取ります。対応する信
号であれば、Reel、Clip name、ISO、White Balance、Shutter、Lens を自動入力できます。

診断チップ: TC  タイムコード検出、 REC  レコードフラグ検出、 ANC  付帯メタデータ検出、 Audio  エン
ベデッドオーディオの状態、 OCR  HUD OCR の状態。自動入力がうまくいかない場合は、まずこれらのチップ
を確認してください。

HUD OCR

ANC にメタデータを載せないカメラ（多くのミラーレスや一部のシネマ機の HDMI 出力）では、First Rush が画
面上の HUD を OCR で読み取ります。読み取り対象は、Reel 名、Clip name、ISO / EI、Shutter、White
Balance / Tint、対応する Lens データです。HUD 領域を 1〜2 秒ごとにサンプリングし、ベンダーごとのレイア
ウト（ARRI / RED / Sony / Blackmagic）と照合したうえで、Vision フレームワークでテキストを認識します。
値を入力するのは Auto-fill  がオンで、かつ認識に成功した項目のみです。

良好な結果を得るには、HUD がフレーム内にはっきり映っている必要があります。濃いモニタリング LUT やダウ
ンコンバーターを介すと、OCR の精度が下がることがあります。 Help > Export SDI Diagnostic…  には
OCR の試行 / 成功回数が含まれます。認識がうまくいかない場合は、これを添付してください。
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章  9

プレビューエフェクトと LUT

インスペクタの Preview / recording effects セクションでは、プレビューの補正とガイドを設定します: Auto
crop、Keep HUD metadata、Grid、Letterbox、Rotation、Flip H / V、Center Cross、Preview LUT。これ
らは既定ではプレビューにのみ適用されます。ファイルへ焼き込みたい場合のみ Apply to recording  をオ
ンにしてください。

Keep HUD metadata  は、スケール / クロップ中でも上部・下部の HUD メタデータ領域を端に固定して見やす
くします。 Auto crop  は黒帯や赤い safe-frame 境界を再検出し、Grid は thirds / fifths / crosshair のガ
イドとして使えます。

アスペクト比とセーフフレーム

Letterbox / Pillarbox ガイド: 16:9 信号の上に 2.35:1、2.39:1、2:1、4:3 のガイドを重ね、フレーミン
グの目安にします（プレビューのみ）。

Portrait / 9:16: Reels / Shorts 向けに Portrait Mode をオンにします。9:16 のクロップ枠をドラッグ
して被写体に合わせ、 Apply to recording  をオンにすると、クロップ済みのフレームで収録できま
す。 Cycle Portrait Mode  を押すと、16:9 -> 9:16 -> 9:16 (左) -> 9:16 (右) の順に切り替わりま
す。

3D LUT プレビュー（.cube）

Preview LUT エリアで Pick LUT…  を開き、 .cube  ファイル（Rec.709 変換、ルック、カメラ LUT）を
選ぶと、ただちにプレビューへ適用されます。適用の強さはスライダーで調整します。 Apply to recording
をオンにすると LUT を焼き込めます。あるいは、クリーンな LOG マスターを残したまま、LUT を焼き込んだ専
用のプロキシデスティネーションを別途用意することもできます。キューブサイズは 17 / 33 / 65 に対応していま
す。
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章  1 0

Live Tools — カラーとスコープ

Live Tools パネル（ Option-Command-G ）を開き、Color タブを選択します。グレーディング対象のソース
は、パネルのヘッダーから選択します。

Live Tools — カラーとスコープ

カラーホイール

Lift、Gamma、Gain、Offset の各ホイールで一次（プライマリ）グレーディングを行います。

ディスク内をドラッグしてカラーバランスを調整します（相対トラックボール方式）。

各ホイールの下のスライダーが、マスター（レベル）コントロールです。

ディスクをダブルクリックすると、そのバランスがリセットされます。

このグレーディングは ASC CDL の演算で行われるため、ロスなく往復できます。 Export .cdl  / Load

.cdl  でグレーディングを受け渡しし、 Save Look  / Looks  でルックを保存・呼び出し、 Copy  /
Paste  でソース間にグレーディングをコピーできます。
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CDL、LUT、表示モード

CDL (ASC)  トグルで CDL グレーディングを有効にします。

Pick LUT…  で、グレーディングの上に重ねる .cube  LUT を読み込みます。

Graded  / LUT only  / Original  のボタンでビューアの表示内容を切り替え、グレーディング適
用後、LUT 単体、未加工のソースを見比べられます。

Sat  スライダーで彩度を調整します。

Bake into recording (CDL -> LUT)  をオンにすると、クリーンなソースではなく、グレーディン
グ済みの画像を収録します。

スコープ

パネルの右側には、ライブスコープ（Waveform、RGB Parade、RGB Overlay、Vectorscope、Histogram、
Chromaticity）が表示されます。スコープをクリックすると、サイズ変更可能な独立ウィンドウで開きます。スコ
ープは選択中のモニタリングカラースペース（Rec.709 / Rec.2020 / P3 / Rec.601）に追従し、HDR モニタリ
ングを含めて正確な値を表示します。
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章  1 1

Live Tools — 露出・フォーカス補助

Live Tools で Monitor タブを選択します。これらの補助表示はプレビュー専用で、収録、SDI 出力、スコープに
は影響しません。

Live Tools — 露出・フォーカス補助

False Color: 露出ゾーンを色に割り当て、ひと目で露出を判断できます。

Zebra: ハイライトのクリッピング領域をストライプで強調します。

Peaking: ピントの合ったエッジを強調し、シビアなフォーカスを確認できます。
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章  1 2

Live Tools — 合成

Composite タブを選択すると、ソースとプレートをリアルタイムで合成できます。グリーンバックのモニタリン
グや、現場でのプレビズに便利です。

Live Tools — 合成

Plate: 合成の背景となるソース / 画像を選択します。

Chroma key: similarity、smoothness、エッジのチョーク、スピル抑制で、グリーン / ブルーを抜きま
す。 Show Matte  でマットを確認しながら調整できます。

Mix、Wipe、Diff: 比較・オーバーレイ用のブレンドモード。Wipe では角度とフェザーを調整できます。

Draw Mask: 楕円 / 矩形のマット（位置、サイズ、フェザー、反転）で、合成範囲をフレームの一部に限定
します。

Composite Monitor: 合成結果を、ビューアグリッド内の仮想タイル（または別ウィンドウ）として表示
します。メインタイルはクリーンなまま保たれます。

Bake composite into recording: 合成済みの画像を収録します。既定ではオフのため、マスターはク
リーンに保たれます。
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章  1 3

Live Tools — クリップ再生

Playback タブを選択すると、First Rush を離れることなく、収録済みクリップの確認や任意のファイルの再生
ができます。

Live Tools — クリップ再生

収録済みのクリップは、クリップリストに表示されます。 Play File…  で任意のムービーを開けます。

トランスポートコントロールで、再生 / 一時停止、フレーム送り、スクラブ、速度を操作できます。プレーヤ
ーウィンドウでは Space（再生 / 一時停止）、← / →（1 フレーム移動）、J / K / L（逆再生 / 停止 / 正再
生）、I / O（IN / OUT）を使えます。

SDI 出力ハードウェアがあれば、再生映像をモニターへ出力できます。ない場合は、First Rush がアプリ内
プレーヤーにフォールバックするため、Mac 上で確認できます。

ハードウェア SDI 再生を使う場合は、SDI Out タブまたは Preferences > SDI Routing で出力ポート
を Clip Playout に指定します。2.3.0 では出力指定とゲーティングが整理され、クリップ再生と Program
Out が同じ出力カードを取り合わないよう保護されます。
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クリップリストはセッション単位で管理され、アプリを再起動するとリセットされます。再読み込みコントロール

で再スキャンでき、行のコンテキストメニューからエントリを削除できます（ファイル自体は残ります）。
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章  1 4

Live Tools — SDI プログラムアウト

SDI Out タブを選択すると、ソースを SDI 出力コネクタにミラーリングできます。

Live Tools — SDI プログラムアウト

Program out (mirror this source to SDI output): ソースを、出力対応のカードコネクタへ送ります。

Processed — grade, composite, rotation applied to output: オフのときは、クリーンなフィード
（生入力のミラー）が出力されます。オンのときは、プレビューで見ているのと同じグレーディング、合成、

回転を反映して SDI 出力します。2.3.0 からは、この処理済み出力が DeckLink だけでなく、対応する
AJA SDI 出力にも適用されます。

AJA 出力は HD / 2K progressive ワークフローを前提にしています。2.3.0 では、フリーランのカメラ入力
で映像が縦方向に流れることがある問題も安定化されています。

プログラムアウトには、出力として構成されたカードコネクタが必要です。SDI Out タブまたは Preferences >
SDI Routing を参照してください。
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章  1 5

外部モニター（AVOut）

External Monitor  メニューでは、メインウィンドウとは別に、監督やクライアント向けのディスプレイに表
示するフルスクリーンのモニタリングウィンドウを開けます。

Add AVOut Window : 新しい出力ウィンドウを開きます。対象のディスプレイに配置し、表示するソース
を選択します。

Close All AVOut Windows : すべての出力ウィンドウを閉じます。

AVOut ウィンドウはモニタリング専用です。収録は常にメインのデスティネーションで処理されます。4 系統以
上を同時に収録する場合は、安定性のために AVOut ウィンドウを 1 ソースに留めてください。
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Companion Viewer（iPhone / iPad）

Companion Viewer は、モニタリング用プレビューを iPhone や iPad へストリーミングします。接続には同じ
ローカルネットワークを利用するか、現場にルーターがない場合は直接（P2P）接続します。Viewer はモニタリン
グ専用で、収録は一切行いません。

Companion Viewer > Companion Viewer… （ Command-Option-V ）を開きます。

Companion Viewer パネル

Viewer アプリのインストール

First Rush Viewer は無料の iPhone / iPad アプリです。App Store で「First Rush Viewer」を検索してくだ
さい。動作には iOS / iPadOS 17 以降と、ローカルネットワークの許可（初回起動時に確認されます）が必要で
す。カメラの許可は QR ペアリングにのみ使用されます。

接続

1. Mac で Companion Viewer パネルを開き、サーバーを起動します。 Create Pairing Code  を押す
と、起動とコード発行が 1 ステップで完了します。

2. 6 桁のコードと QR コードが表示されます。
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3. デバイスで First Rush Viewer を開くと、Mac が自動的に検出されます。

4. Mac を選択し、6 桁のコードを入力するか、QR コードをスキャンします。

5. レイアウト（ 1 Cam 〜 4 Cam ）と、表示するカメラを選択します。

Mac は Bonjour により、同じローカルネットワーク上の Viewer アプリに表示されます。コードは 5 分間有効
で、複数のデバイスをペアリングできます。ペアリング済みのデバイスは自動的に再接続します。サーバーまたは

アプリを再起動するとペアリングはリセットされるため、新しいコードを発行してください。

ルーターがない場合（P2P）

共有 Wi-Fi がない場合、Mac とデバイスは直接接続します（Mac 側は First Rush 2.0.1 以降、Viewer 側は 2.0
以降が必要です）。特別な設定は不要です。P2P では帯域を抑えるために品質が自動的に制限されます。より高い
品質が必要な場合は、共有 Wi-Fi を使用してください。

セキュリティと制限

収録は常に Mac 側で行われます。Viewer には VIEW ONLY  が表示されます。

6 桁のコードがなければ接続できません。

画面収録やミラーリングが検出されると、映像は非表示になり、 Screen Capture Protected  が表
示されます。

送信されるのは映像のみで、オーディオとタイムコードは送信されません。

Mac 側のライブカラー / 合成は Companion ストリームには反映されず、生のカメラ映像が送信されます。
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章  1 7

オンセット制御とリモート補助

インスペクタには、現場での制御を補助する機能もあります。

Stream Deck: Elgato Stream Deck を USB で接続し、ボタンごとに動作を割り当てます。HID 接続を
有効にするとデバイスを検出し、Record / Stop / Pause / Take / Marker 系の操作を割り当てられます。

Network Sync: 複数台の Mac を Leader / Follower として同期するための現場向けオプションです。1
台を Leader、残りを Follower にして、リモートセッションの状態を揃える用途に使います。

Web Remote: 同じ LAN 上のブラウザから http://<このMacのIP>:ポート  にアクセスし、基本的
な遠隔操作を行えます。信頼できる現場ネットワーク内だけで使い、外部インターネットには公開しないでく

ださい。
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章  1 8

アクティビティログと診断

View > Activity Log  を開きます。

アクティビティとログ

Activity & Logs ウィンドウには、CPU、メモリ、空きディスク容量、実行中の収録に加えて、ソースおよび収録
のイベントが表示され、検索、消去、書き出しが行えます。信号の問題を報告するには、Help メニューを使用しま
す: Copy SDI Diagnostic 、 Export SDI Diagnostic… 、 Email SDI Diagnostic… 。診断に

は、アプリのバージョン、信号フォーマット、タイムコード、レコードフラグ、オーディオチャンネル、直近の ANC
サマリー、OCR の試行 / 成功回数、メタデータソースの状態が含まれます。
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章  1 9

環境設定

Command-,  で環境設定を開きます。タブは 4 つあります。

環境設定 — General

General: 言語（macOS のシステム言語に従います）、既定のビューアレイアウト、既定のパネル、システ
ムダッシュボード、ソースサイドバー、インスペクタ、スレートバー、Live Tools パネルの Display /
Panels トグル。同じタブで Still Capture と設定リセットも管理します。

Still Capture: 保存フォルダ、PNG / JPEG / TIFF 形式、グレード焼き込み、AMF/CDL ルックサイドカ
ーを設定します。

Reset Settings: ウィンドウ / プレビュー、Slate、アプリ既定設定をリセットします。ライセンス、デステ
ィネーション、ソース別の収録プリセットは保持されます。

Shortcuts: Wacom タブレットの ExpressKeys を First Rush のアクションに割り当てます（F13
Record all、F14 Stop all、F15 Pause、F16 Take +、F17 Take −、F18 Chapter marker、F19 Select
all sources）。通常のキーボードでのフォールバックとして、 Command-R  / Command-K  /
Command-M  が使えます。
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環境設定 — Shortcuts

SDI Routing: カードごとに各コネクタを入力または出力として割り当て、出力を Program Out またはク
リップ再生にマッピングします。出力に設定したコネクタはソースリストから外れますが、サイドバーの SDI
Output Ports 行から元に戻せます。2.3.0 からは、パッチベイで入力の点を出力の点へドラッグして PGM
OUT 接続を作成できます。従来どおり、入力点を選んでから出力点をクリックする方法も使え、接続済みの
出力を再度クリックすると解除できます。
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環境設定 — SDI Routing

License: サブスクリプション / トライアルの状態とライセンス管理。支払い失敗時の猶予、オフライン猶
予、期限切れ状態もここで確認できます。
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章  2 0

トラブルシューティング

No signal — カメラの出力フォーマット、キャプチャカードの入力ルーティング、SDI / HDMI ケーブル、ベンダ
ー純正ユーティリティでのデバイス認識、そしてソースが有効になっているかを確認します。

No audio — カメラ出力にエンベデッドオーディオが載っているか、ソースのチャンネル数とビット深度、デステ
ィネーションのオーディオトラック、チャンネルマッピング、ミュート / マスターボリュームを確認します。

Auto record won't start — ソースの Auto record がオンか、デスティネーションが割り当てられているか、
トリガーモード、REC フラグ（SDI）または HDMI TC 設定（Sony）、そしてアクティビティログの REC  /
STBY  / クールダウンのメッセージを確認します。

Metadata won't auto-fill — TC  / ANC  / OCR  チップ、カメラが実際にメタデータを送出しているか、
コンバーター / ワイヤレス / スイッチャーが ANC を除去していないか、HUD が読み取れる状態か、Auto-fill が
オンかを確認します。

File name unexpected — スレートモード、Scene / Cut / Take の値、デスティネーションのトークン、カメ
ララベル、 Auto +Take  を確認します。

スチルが想定外のフォルダに保存される — Preferences > General > Still Capture  の保存フォル
ダを確認してください。空の場合は、デスティネーションフォルダ内の Stills  が既定値です。

Viewer アプリで Mac が見つからない — Mac と iPhone / iPad が同じローカルネットワークにあるか、Mac
側で Companion Viewer サーバーが起動しているか、iOS の Local Network 権限が許可されているかを確認し
てください。

Help メニューのチャットボットが開かない — Help > AI Assistant  は
https://editorhan.me/first-rush/help  を開きます。現場ネットワークで外部インターネットが遮断
されている場合に備えて、PDF マニュアルも手元に保存してください。
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章  2 1

オンセットチェックリスト

最初のテイクの前: キャプチャデバイスが認識されている、すべてのソースが表示されている、信号・タイムコード・
オーディオが確認できている、デスティネーションフォルダが設定されている、コーデックプリセットを確認した、

ファイル名のプレビューを確認した、Scene / Cut / Take を設定した、自動収録を使う場合はトリガーモードを確
認した、短いテスト収録を編集アプリで開いて確認した。

撮影中: 赤い収録ボーダーと REC タイマーを確認する、空きディスク容量を確認する、Auto +Take を確認する、
メタデータが重要な場合は TC / REC / ANC / Audio / OCR チップに注意する。

設定変更後: 信号フォーマット、オーディオのチャンネルマッピング、トリガーモードを再確認し、改めて短いテス
ト収録を行う。
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章  2 2

キーボードショートカット

収録: Command-R  Record All、 Command-K  Stop All、 Command-P  Pause All、 Shift-Command-

P  Resume All、 Command-M  チャプターマーカー、 Shift-Command-S  Save Still。

スレートとメタデータ: Scene / Cut / Take の編集内容は自動で適用されます。 Command-]  / Command-[
Take +/−、 Shift-Command-]  / Shift-Command-[  Scene +/−、 Option-Command-]  /
Option-Command-[  Cut +/−。

選択: Cmd-Click  ソースの複数選択、 Shift-Click  範囲選択、 Command-A  すべてのソースを選択。

表示とレイアウト: Command-1  / 2  / 3  / 4  Single / 2×2 / 3×3 / 4×4、 Option-Command-0

Auto Layout、 Command-F  フルスクリーン切り替え、 Option-Command-S  ソースサイドバー、
Option-Command-I  インスペクタ、 Option-Command-L  スレートバー、 Option-Command-G  Live

Tools パネル、 Option-Command-Y  アクティビティログ。

出力: Command-Option-V  Companion Viewer パネル、 Shift-Option-Command-O  AVOut ウィンド
ウ追加、 Shift-Option-Command-W  AVOut ウィンドウをすべて閉じる。

正式なショートカットは、各メニュー項目の横に表示されているものです。一部のショートカットは、ビルドや

macOS 環境によって異なる場合があります。
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章  2 3

メニューバーリファレンス

First Rush

About First Rush （バージョン / ビルド / ビルダー）、 Check for Updates… （Sparkle）、
Preferences… （ Command-, ）、 License… 、 Hide / Quit 。

File

New Window 、 Close 。

Edit

標準の macOS 編集メニュー（Undo / Redo / Cut / Copy / Paste / Select All）です。スレートやテキストフ
ィールドで使用します。

View

Show Tab Bar  / Show All Tabs 、 Toggle Source Sidebar 、 Toggle Inspector

（ Option-Command-I ）、 Toggle Slate Bar （ Option-Command-L ）、 Live Tools Panel
（ Option-Command-G ）、 Activity Log （ Option-Command-Y ）、 Enter Full Screen 。

Recording

Select All Sources 、 Record All （ Command-R ）、 Stop All （ Command-K ）、 Pause

All （ Command-P ）、 Resume All （ Shift-Command-P ）、 Insert Chapter Marker

（ Command-M ）、 Save Still （ Shift-Command-S ）、 Save Stills (All Cameras) 。
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Recording メニュー

Layout

Auto Layout 、 Single 、 2 x 1 、 2 x 2 (4) 、 3 x 3 (9) 、 4 x 4 (16) 、 Primary +

Right Strip 、 Enable Portrait Mode (CW 90°) 、 Cycle Portrait Mode 、 Toggle

Fullscreen 。

External Monitor

Add AVOut Window 、 Close All AVOut Windows 。

Companion Viewer

Companion Viewer… （ Command-Option-V ）、 Start Companion Viewer 、 Create

Pairing Code 。
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Window

標準の macOS ウィンドウメニュー。

Help

AI Assistant （Web チャットボット）、 Email Developer 、 Copy SDI Diagnostic 、 Export

SDI Diagnostic… 、 Email SDI Diagnostic… 、 Bug Report… 、 Open Activity Log 。

メニュー項目とショートカットは、ビルドや環境によって若干異なる場合があります。正式なものは、画面上に表示

されるメニューです。


